
Copyright © 2016 The eVSM Group, All Rights Reserved 

Mfg 

Data

Lead 

Time

Control 
Center

Customer
Electronic Info 

Arrow
Finished 
Goods

Inventory
Outside 
Source

Process
Shared 
Process

Summary Truck
Units 

Converter

ACME Scissors Manufacturing

Current State

Z020

Customer

7000
Customer 

Daily Demand
Item

1

14

Day

Hr

60

Hr

Min

60

Min

Sec

1
Activity Lead 

Time
Day

A010

ATLAS Warehouse

1

1.07 Day

Type

7500Inventory Item

A030 1

1.00 Day

1
Time 

Between
Day

A020 1

0.80 Min

1Associates Staff

10Qty Per Cycle Item

0.8Cycle Time Min

0.08Cycle Time Per Item Min

0.07Activity Takt Time Min

Mold Handles

A050

0.08Activity VA Per Item Min

1

0.55 Day

Blanks

3850Inventory Item

A060 1

2.20 Min

1Associates Staff

10Qty Per Cycle Item

2.2Cycle Time Min

0.11Cycle Time Per Item Min

0.12Activity Takt Time Min

Sharpen

A070

0.11Activity VA Per Item Min

1

0.39 Day

Sharp Blanks

2700Inventory Item

A080 1

0.50 Min

1Associates Staff

10Qty Per Cycle Item

0.5Cycle Time Min

0.05Cycle Time Per Item Min

0.09Activity Takt Time Min

A090

0.05Activity VA Per Item Min

1

0.44 Day

Drilled Blanks

3100Inventory Item

A100 1

1.00 Min

1Associates Staff

10Qty Per Cycle Item

1Cycle Time Min

0.10Cycle Time Per Item Min

0.12Activity Takt Time Min

Assemble

A110

0.10Activity VA Per Item Min

1

1.29 Day

Scissors

9000Inventory Item

A120 1

MRP

Production

Control
Forecast 30 Days

Weekly Order

Daily

Daily

Weekly Schedule

Z010

Time Summary 1

0.12Takt Time Min

4.50
Total Value 

Added
Min

6.74Lead Time Day

0.08
Value Added 

Percent
%

1

Z140

Time Summary 2

0.12Takt Time Min

5.00
Total Value 

Added
Min

0.35Lead Time Day

1.71
Value Added 

Percent
%

2

1.00 Day

1
Time 

Between
Day

A150 1

5.00 Min

1Associates Staff

120Qty Per Cycle Item

5Cycle Time Min

0.04Cycle Time Per Item Min

0.12Activity Takt Time Min

Cardboard Boxes

A160

0.04Activity VA Per Item Min

2

0.34 Day

Boxes

2400Inventory Item

A170 2

2

2Stations Stn8
Activity Time 

Per Day
Hr 9000

Activity Daily 
Demand

Item

Drill

MRP

Production

Control

Customer
Outside

Source

Process
Shared Process

Summary 60

Hr

Min

1

Cycle Time / Takt Time Chart

M
in

0

0.02

0.04

0.06

0.08

0.1

0.12

A050

M
ol
d 

H
an

dl
es

A070

S
ha

rp
en

A090

D
ril
l

A110

A
ss

em
bl
e

A160

C
ar

db
oa

rd
 B

ox
es

Cycle Time Per Item

Activity Takt Time

Lead Time Summary
Day

0 1 2 3 4 5 6 7

A010

ATLAS 

Warehouse

A020

Truck

A030

Type

A060

Blanks

A080

Sharp Blanks

A100

Drilled Blanks

A120

Scissors

A150

Truck

6.75

Activity Lead Time

Non Value Added

Value Added

eVSM v9 Functions 

Reference Manual

Use CTRL + F to search within this document

eVSM Help materials include tutorials, examples, and reference. This manual contains the 

reference help. For tutorials and examples, visit evsm.com/help. The manual organization follows 

the organization of the eVSM Toolbar.

The manual is designed both for on-screen viewing and print. For on-screen usage, the manual is 

best viewed in Acrobat Reader. To search, use the Ctrl+F shortcut. Also, it is a good idea to set 

the Acrobat view to "Show two pages side-by-side".

For hardcopy, print the manual on double sided paper and use the table of contents or the index 

to quickly find answers to your questions.
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Value stream mapping provides a high level view of a lean deployment. Its methodology is well 

laid out in the series of workbooks from the Lean Enterprise Institute (www.lean.org). The eVSM 

software has been designed to complement these workbooks and provide lean practitioners a tool 

to support their value stream mapping activities, starting from paper and pencil through 

improvement projects, leading to a leaner future state.

The primary modules in eVSM (Sketch, Sequence, Validate, Calculate, Visualize, Improve) are 

deliberately organized to match the process steps that we have seen practitioners follow in their 

mapping activities.

We have seen eVSM used in three ways in our user community:

1. By practitioners who simply want to capture a map electronically and want access to a 

complete VSM icon set that is easy to use.

2. By practitioners that want to draw a map and do simple calculations in Excel corresponding 

to data on the map.

3. By practitioners who want highly standardized and automated maps to include icons as well 

as variables, lean equations, charts, and improvement methodology. 

While the third approach best leverages the software in a lean deployment, its drawback in the 

past has been the learning curve associated with its usage. eVSM has introduced ready-built 

stencils for different application areas to address this issue. In eVSM v9, the following stencils 

are available. 

§ Quick Enterprise- supply chain and logistics maps

§ Quick Manufacturing- plant level maps for discrete parts

§ Quick Processing- plant level maps for food products and chemical processing

§ Quick Transactional Pro- transactional processes 

§ Quick Healthcare- patient flows in hospitals

§ Quick MCT- supports manufacturing critical path time calculation assorted with Quick 

Response Manufacturing

One hour webinars are available to overview each of the stencils. Contact support@evsm.com for 

details.    

eVSM Overview

1. The eVSM Environment

2
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM vX.XX) is on the right of the screen. 

We will refer to this as the “Main Stencil”. Its important that this stencil is never closed. The 

main stencil is organized into sub-stencils, so that it is easier to find shapes, and are also found 

on the right.

Any Quick eVSM stencils (such as Quick Mfg) are docked on the left of the screen. We will refer 

to such stencils as the “Quick Stencil”. Click and drag the Quick Stencil header bar to move it to 

this docked position.

Quick Stencil

Main Stencil

eVSM Pre-requisites and Updates

eVSM requires Windows XP/Win7/Win8/Win10 (32-bit and 64-bit), Visio 2003-2016 (32-bit and 

64-bit), and Excel 2003-2016 (32-bit and 64-bit). You can check on the latest eVSM version 

available at: www.evsm.com/updates

The best way to start a blank value stream map is to double-click the eVSM icon on your 

desktop. If your Visio security setting is set to anything but low, messages will come up 

asking for permission to “Enable Macros”. You must answer “Yes” to these messages for 

eVSM to operate. 

Starting eVSM

The Help button on the toolbar requires an internet connection and will open up a web browser 

pointed to the eVSM help site at www.evsm.com/help.

The help site is tested with Internet Explorer which is the recommended browser if there are any 

problems. We offer technical support for the latest release of the eVSM software through our 

Maintenance, Enhancement, and Support program.. Please email us at support@evsm.com.

eVSM Help Site

Help

3
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eVSM has a collection of value stream mapping shapes that appear in the main 

eVSM stencils to the right of the drawing page.

These shapes, behaviors, and corresponding functions have been designed from 

the outset to support the series of lean workbooks from the Lean Enterprise 

Institute (www.lean.org) and its worldwide network partners. The primary 

workbook impacting the design has been “Learning To See”.

As software usage has become widespread across multiple industries, the icon 

language has been extended to keep pace with practitioner requests and lean 

publications in each industry. 

eVSM Shapes & Stencils

To resize the page, hold down the CTRL key and move the cursor to the middle of the edge of 

the page. The cursor will turn into a double-headed arrow. Simply grab the edge and pull it to the 

required size.

Page Resizing

In addition to the basic icons to the right of the drawing page, eVSM includes Quick stencils for 

Manufacturing, Enterprise, Processing, Transactional, Warehousing, and Healthcare. 

These quick stencils offer rapid map development complete with automated analysis and 

charting. 

eVSM v9

4
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Re-opening eVSM Stencils

eVSM Stencils must always be kept open when working with maps. If you have “lost” the eVSM 

stencils from your drawing file, here are the steps to re-open them.

In Visio 2003/2007:

§ Click “File > Shapes > Open Stencil…”

§ Navigate to the following folder: “C:\Program Files\eVSM\Setup\Solutions”

§ Select the eVSMIcons.vss stencil file in this folder and then click the Open button.

§ Save your Visio file so it “remembers” this stencil for next time.

In Visio 2010/2013/2016:

§ In the Shapes pane (on left) click "More Shapes > Open Stencil..."

§ Follow the same steps as above.

Note that on 64-bit Windows, the file location is:  "C:\Program Files(x86)\eVSM\Setup\Solutions"

Resizing Shapes

Shapes are designed to be grid-sized. The drawing page has a grid on it. Snap shapes to grid 

locations for easy alignment.

Snap To Grid

Avoid resizing shapes whenever possible. Shapes are designed to fit together and resizing a shape 

will make “fitting” shapes together difficult and create extra work.

Double-click a shape to edit its text.

Text Editing

5
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Text on 

Connector

Text on 

Connector

Manipulating Text on Connectors

Text can be added to any connector by double-clicking and typing.

The Visio Text Block Tool can be used to move the text position along the arrow. Note: The Text 

Box Tool is part of Visio, not eVSM tools, and can be found in the Visio menu.

Text on 

Connector

Caution: Be sure to de-select the 

Text Block Tool when finished. 

Drag & Drop

Drag and drop eVSM icons from the stencil onto the drawing page.

Blue icons represent stacks of shapes. Access the stack by dragging out the shape 

and then clicking the right mouse button.

Cross Dock

In_Store Storage

Moment_Of_Truth

Picture Process

Process

Process Cell

Production Control

Rework Process

Shared Process

Warehouse

Process

Manipulating Text

Twice per 
week

Double-click a shape to edit its text.

The Visio Text Block Tool (located behind the Text Tool in the Visio Standard 

toolbar) can be used to move the text relative to the shape location.

The Text Block Tool displays control handles around the text belonging to a shape. 

These control handles can be used to position and size the text block.

Twice per week

Twice per 
week

Text Block Tool

Caution: Be sure to de-select the Text Block Tool when finished. 

Straight Arrows

Icons with a blue square in the top right corner symbolize that shapes in that icon stack are used 

for visual purposes only, and not used for calculations. 

6
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Visio Pages

Pages can be created, deleted, etc. via the right mouse menu on the page tabs.

Rules for Visio drawing page naming:

· Page names must start with an alpha character.

· Page names must be limited to 0-9 and A-Z characters. Characters such as [!@#$%^&*()|+-
?] are not allowed.

· Page names should be kept as short as possible.

Insert Page…

Delete Page

Rename Page

Reorder Pages...

Zooming In and Out

§ CTRL-SHIFT-Drag Select region (Zoom into the selected region).

§ Try the Visio menu “View > Task Panes > Pan & Zoom” for another navigation option with 

a mini-window.

§ To set up the mouse scroll wheel to zoom, use the Visio menus: “File > Options > 

Advanced” and check:

§ Visio 2010 has zoom controls at the bottom right of the window.

Visio shapes can simply be selected, copied and then pasted into other Microsoft office 

applications like PowerPoint and Excel. Be sure to paste a picture using the “Paste As…” 

command. This will allow re-sizing of the pasted picture without requiring editing and font 

adjustments.

Copy and Paste into PowerPoint or Excel

Acrobat PDF

Convert to Bitmap

Acrobat PDF allows capture of any size drawing in a single file, which can be viewed with the 

free Acrobat Reader, and is easily printable. On-screen viewing is good, it is searchable, and 

supports password security. Visio 2010 allows direct creation of PDF files. 

Common bitmap formats such as JPEG, GIF, and TIFF can be viewed in most browsers without 

any additional software. eVSM maps can be converted to these and other graphic formats from 

the “File>Save As…” menu. In the “Save As” dialog, click the “Save as type” pull-down and 

select the format.

Zoom on roll with InteliMouse

Center selection on zoom

7
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Visio allows drawings of any size. The drawings can then be printed on any size paper supported 

and available on the printer.

When the drawing size does not match the paper size, you can either print across several sheets, 

or shrink (or expand) the drawing to fit the paper by clicking “File>Page Setup…” and then 

checking the “Fit to 1 sheet” radio button.

Printing

The “File>Print Preview” function can and should be used to assess the print output before 

committing the drawing to paper.

Printing Problems

The eVSM Software essentially generates a Visio file. The printing of the file is handled by 

standard Visio functionality. Problems printing from Visio could be due to Visio, the print driver, 

or the printer.

Here are some suggestions if you have problems printing from Visio:

§ Make sure you have the latest Visio Service Patch installed

§ Try copy/pasting your VSM to PowerPoint or Excel and then print from there

§ Convert your VSM to Acrobat PDF and then print the PDF file

8
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DON’T  resize eVSM Shapes whenever possible.

DO Snap shapes to grid locations.

DON’T  close eVSM Stencils.

DO zoom in fast with CTRL-SHIFT-Drag.

DO zoom out quickly with CTRL-SHIFT-W

DO use a mouse to be productive with eVSM.

Do’s and Don’ts

9
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2. Sketch

Overview

Lists the sketcher stencils available and allows one to be selected. The 

corresponding Quick Stencil will also be activated. Note that only one 

sketcher stencil can be used per map.

Open

NUM Opens the Name Unit manager which manages the names, units and 

equations used on this map. If used in conjunction with a Quick 

Stencil, its important NOT to modify variable and unit names or 

equations. Typically a few unit names might be added.

View a window showing all data for the selected center.

This section is focused on the first electronic capture of a map and data input. This area is ONLY 

for those using Quick stencils. 

List Variables

Wall Map Import a photo of an existing value stream map, and scale for drawing 

the map in eVSM.

How Do I Use the Sketch Module?

The Sketch Module allows you to quickly capture a wall map in eVSM. It can also be used to 

simply capture the flow of the value stream with no data. Built in commands allow you to add the 

data later when needed. The main steps in the Sketch Module are:

1. Use the Wall Map button to import your wall map picture(s) into eVSM, and scale the image.

2. Use the Open button to select the application area (manufacturing, services, etc.) for your map.

3. Use the Sketch stencil to capture the flow over the wall map image. 

4. Once the initial capture has been done, add data to the map and enter the data. 

10
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1a. Import Single Image Wall Map

The Wall Map function provides an efficient way to convert an image of the wall into an 

electronic VSM. If your wall map is simple enough to capture in a single clear photo (must be 

able to read all text), then import the image into eVSM with the steps below. If the map is 

complex and requires multiple images then see section 1b on the next page. 

Wall Map

2. Click the Insert Wall Map button to 

browse for your wall map picture on 

your computer.

3. Select the picture and click Open.

4. To scale the picture, draw a rectangle 

over any one process box. Click the 

Done button when finished.

1. Click the Wall Map button in the toolbar.

Try this:

11
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5. Next a form will appear allowing you to change the 

transparency of the picture, make it visible/invisible 

on the page, or delete the picture. After you click OK, 

if you need to get back to this form, click the Wall 

Map button in the toolbar again.

1b. Import Multi-Image Wall Map

For more complex maps requiring multiple images, here are some tips for good results:

a.) Take all photos from approximately similar distance from the wall. This will ensure 

similar scale.

b.) Capture sufficient overlap between pictures so nothing is missed.

c.) Ensure lighting is similar for all photos.

d.) Hold camera square to the wall to minimize skewing of the image.

2. Line up the pictures so that the wall map is aligned 

properly. 

1. Use the Insert>Picture option in Visio to import all of the pictures onto your Visio page.

3. Hold down the SHIFT key and select each picture. 

Right-click on the selected images and choose 

“Copy”.  

4. Delete the images from the Visio page.   

5. Right-click on the page and select “Paste Special”. 

Choose the “Picture (Enhanced Metafile)” option and 

click OK.

6. The image will become the background of the Visio 

drawing page, allowing you to drop shapes on top 

without it moving. To delete the image, click the 

Wall Map button in the toolbar. 
Wall Map

Wall Map

12
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8. Click the Wall Map button in the toolbar, and follow the steps on the previous page of 1a. 

7. Click File>Save As. Name the image and then in the “Save as Type” dropdown, select 

“Graphics Interchange Format (*.gif)”. Click Save.

6. All of the images should now be joined into 

one single image now. Crop or resize the 

image to fit the desired drawing page size. 

13
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Customer

Process

Type

Process

The shapes shown above are those used in the example map.

As with all eVSM drawings, start your map by dragging out the red shapes (Customer Sketch and 

Time Sketch) first.

1. To start drawing on your map, click on the Open button in the toolbar to open up the 

Sketcher stencil. From the pop-up menu, select which kind of map you’re drawing, for 

example, Quick Manufacturing. There is a separate Sketcher stencil for each of the Quick 

Stencils used in eVSM.  
Open 

2. Once you select what type of map you’re drawing, the corresponding Quick Stencil will be 

placed in the forefront of the other Quick Stencils. Also, the Sketcher stencil will open with 

all of the shapes associated with that type of map.

2. Select Stencil Using the Open Form

5

Wk

day

xx

Wk

shift

xx

shift

Hr

Try this:

14
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If you’re using a picture of a hand-drawn map as a guide, start dragging out the different Sketch 

shapes on top of each process as shown below. Otherwise, just recreate your basic process using 

the different Sketch shapes.

An alternative method can be done once a red shape has been 

placed on the drawing page. You can use the right mouse button 

menu (shown to the right) and select the various Sketcher shapes 

to drop them at the location clicked on the page.

Note: If you need additional map space, 

hold down CTRL and click and drag the edge of the page.

 

Process

Type

Process

Type

Customer

14

Day

Hr

5

Wk

Day

Type

Process Process

Type

3. Capture the Flow with the Sketch Stencil

15
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Now you can either add data to an individual shape or to the whole map. If you right-click on 

any shape, you will see 4 options regarding the adding and removing of data:

· Add all data (shape): adds input and calculated data to the specific shape that you have 

selected 

· Add all data (page): adds input and calculated data to all shapes on that particular page

· Remove all data (shape): eliminates the input and calculated data from the specific shape that 

you have selected 

· Remove all data (page): eliminates the input and calculated data from all shapes on that 

particular page

For this example, right-click on any shape and select “Add all data (page).

Process
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Process

Type

Customer

Type

Process Process

Type

Customer 
Demand

Item
Day

xx
Activity Lead 

Time
Dayx.xx

Transport 
Frequency

Trip
Day
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rt Time

Minxx Transport 
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Trip
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rt Time

Minxx

Inventory Itemxx Inventory Itemxx Inventory Itemxx Inventory ItemxxCycle Time Minx.xx Cycle Time Minx.xx Cycle Time Minx.xx

Qty Per Cycle Item1 Qty Per Cycle Item1 Qty Per Cycle Item1

A001
0

A002
0

A003
0

A004
0

A005
0

A006
0

A007
0

A008
0

A009
0

A010
0

A011
0

14

Day

Hr

5

Wk

Day

4. Add data to the map
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Atlas

Blanks

Mold Handles

Molded Blanks

Customer

Drilled Blanks

Sharpen Assemble

Scissors

Customer 
Demand

Item
Day

700
Activity Lead 

Time
Day0
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W

1
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rt Time
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Min30

Inventory Item7500 Inventory Item3850 Inventory Item3100 Inventory Item9000Cycle Time Min3 Cycle Time Min4 Cycle Time Min6

Qty Per Cycle Item5 Qty Per Cycle Item5 Qty Per Cycle Item10

Annotate the map and fill in the values according to your wall map. Now you can finish the map 

by adding arrows from the eVSM Arrows stencil and add-on variables from the Quick stencil.
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20

A01

30

A01

40
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50

A01

60

A01

70

A01

80
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90
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DayAuto

MinAuto

DayAuto

MinAuto

DayAuto

MinAuto

DayAuto

14

Day

Hr

5

Wk

Day
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If you want to create a custom unit that you would like to use throughout the map, start with the 

Name and Unit Manager. If you want to use a built-in unit but need to convert it, such as Weeks 

to Days, start with Step 3.

1. Click the Name and Unit Manager button in the eVSM toolbar.

Units Handling

NUM

Try this:

2. Click on the “New Unit” 

button in the form and 

create a new unit named 

“Part”.

18
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60

Hr

Min

2

Part

Item

60

Hr

Min

3. Drag out a Units Converter shape from the eVSM Data stencil or the main stencil on the right 

of the screen. 

4. Double click on the default unit “Hr” to change the top unit 

to “Part” and the default unit “Min” to change the bottom 

unit to “Item.” This allows the calculator to account for the 

new unit. The top unit is the original unit, while the number 

specifies how many of the bottom unit makes up one of the 

top unit.

19
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5. If you have more than one custom unit, repeat step two and three.

2

Part

Item

60

Box

Part

Inventory Itemxx

A0010

Type

Inventory Boxxx

A0020

Type

6. Double-click on the unit.

Note: Only the custom units that you created via a unit converter(s) will appear in the form when 

trying to change a variable unit on a center. This is to avoid (for example) people converting 

quantity units to time units for a center, like the Inventory Center. To ensure that the units you 

want to change appear in the form, create the converters first between any units you plan to use. 

7. This form appears showing 

that it is “legal” to 

convert “Item” to “Box” 

or “Part” because unit 

converters exist between 

these three.

8. Selection of “Box” in the 

form causes the unit to be 

replaced in the data box.

P P

20
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Miscellaneous Tips

eVSM comes with built-in basic unit conversions that don’t require a Units Converter. To check 

and see which unit conversions are included, open the NUM and click “Unit Converters.”

If the conversion you need isn’t listed, you will need to 

include a Units Converter on your map in order to use 

your units. If the conversion you need is listed then you 

will not need to include a Units Converter. An error 

may appear if you add an additional Units Converter for 

a conversion that is included in eVSM, such as hours to 

minutes.

21
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The Name & Unit Manager (NUM) provides a simple way of managing the names and units on a 

map via this toolbar button.

The purpose of this management environment is to:

1. Provide a means to type in a name only once and then use it consistently through out the 

map.

2. Provide a means to associate a default unit with a name so that when a name is selected, the 

unit is automatically set.

3. Provide a means of creating a starter set of names and units for different application areas 

such as manufacturing, healthcare, etc. This will allow a company to create standard 

variable sets and deploy them easily.

Managing Names & Units

NUM

The NUM function does not allow editing of names and units directly in the data shapes. New 

names must first be added to the NUM form. Then they can be accessed via right mouse button 

menus on the following data shapes.

Long NVU Short NVU Value Added Non Value Added Units 

Converter

Name Unitx.xx Name Unitx.xx Minx.xx Dayx.xx
60

Hr

Min

The NUM form is divided into three parts: Sets, Units, and Names. Names and units visible in 

this dialog box represent the Current Set. Only the Current Set names and units are available on 

the right mouse button menu of datasets.

Saved Sets
Add New Units

Current Units

Current 

Names

Add New 

Names

Unit Converter Visibility

22
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Double-click on “Item/Day,” which will bring up a Unit Selection option. 

The Numerator can be changed to a different name, such as “Screw” rather 

than “Item,” and the Denominator can be adjusted to a different demand, 

such as items per hour. 

If you need to add a new unit, click on “Manage Names and Units…” 

which launches the Name and Unit Manager. 

Fractional Units

Fractional units make computing demand or production much easier. 

Customer

Customer 
Demand

Item
Day

xx

For the Customer Center, the default unit is items per day. If demand 

is calculated on a different basis though, it is simple to change the 

units. 

Customer

Customer 
Demand

Screw
Hr

xx

This shows the original Customer Center 

converted to screws per hour.

When adding a custom unit as a numerator or denominator, it needs to be linked to its units 

family using a Units Converter shape.  For example, if you're trying to change a unit into "$/

Screw," instead of "$/Item," create a Units Converter showing how many Screws are equal to one 

Item. 

If you need to add a different unit of time, such as year, drag out another “Units Converter” 

shape from the eVSM stencil, add a new unit using the Name and Unit Manager, and specify the 

conversion rate. Make sure you add a Units Converter shape before trying to use a customer unit 

as a numerator or denominator in fractional units. It is easiest to keep track of any time 

conversions by placing them next to the Time Center.

8

Day

Hr

60

Hr

Min

60

Min

Sec

5

Week

Day

Customer

Customer 
Demand

Item
Week

500

Try this:

In this example, “Week” was added as a new unit 

and the conversion to days was made using the 

Units Converter. Next, the Customer Demand was 

changed to items per week. The new unit “Week” 

can be used in any place requiring a unit. 
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Process

List Variables

To see a list of all of the data on a selected center, using the “List Variables” button will bring up 

a form of all of the hidden and visible data.

1. Select the green part of any center on your map. 

List Variables
A0080

1

SecAuto

Qty Per Cycle Item2

Cycle Time Sec10

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

Try this:

2. Click the List Variables button in the toolbar to bring up this form.

P
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Process

3. Using the “List Variables” form, you can quickly edit 

any variable by double-clicking on it. For example, the 

Added Cost for the process was changed the $2 per item, 

even though it is a hidden variable.

There is also a useful browsing feature that makes it easier to quickly look at all the variables 

involved with each center. With the “List Variables” form still open, select another center and 

the data form will change to reflect the data of the new selected center. This allows you to update 

and add values without having to select each center separately.

A0090

1

SecAuto

Qty Per Cycle Item2

Cycle Time Sec10

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

P
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Since the List Variables form can get very long, you can customize what variables are shown in 

the list through the “Variable Visibility” form. Click the “Views” button in the toolbar.

The “Show in List Vars” 

column allows you to select 

which variables will appear 

in the List Variables form.
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Activity Center

Qty Per Cycle Item1

Cycle Time Minx.xx

1

A0010

MinAuto

Inventory Itemxx

A0020

Inventory

DayAuto

1. To move the timeline and get it aligned, you can simply click on the VA or NVA shapes and 

manually move them. 

2. Alternatively, if you want to shift the entire timeline up or down you can right-click on any of 

the timeline shapes and choose “Select Timeline.” If that option doesn’t appear in the menu, 

make sure you have the entire VA or NVA shape selected and try again.

3. With the entire timeline selected, you can then move it to where you’d like it. 

4. Similarly, in the right mouse menu there is an “Align Timeline” function that will create the 

ladder timeline for you if the VA and NVA shapes are not correctly aligned, as shown below.

Selecting & Aligning Timeline

MinAuto

DayAuto    Disable Flying Connector

   Select Timeline

   Align Timeline

MinAuto

MinAuto

DayAuto

MinAuto

eVSM is designed as a grid system and each shape should fit neatly into the lines. If the shapes 

aren’t aligned to the grid, it could lead to later issues and so lining everything up should become 

a habit. It is best to line up the bottoms of each green center and then adjust the timeline, as 

shown below. 

Try this:

P

P
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Aliases are a feature in eVSM that allow a user to convert the variables into another language. 

They can also be used for companies that have a common language that is different than eVSM, 

such as referring to “Stations” as “Worktables.” Using Aliases allows a map’s names and 

variables to be easily updated to fit your needs. 

To start, first create an Excel file with two columns. In the first column, make a list of all the 

variables you would like to create an alias for. In the second column, list whatever you would 

like to variable to be changed to, like using the term “Employees” instead of “Associates,” or 

translating the eVSM term to another language.

In this example, the English eVSM terms are converted to German. Make sure that you label each 

column since the Alias converter starts on the second row in the Excel file. 

Also, label each page in your Excel file to whatever alias you’re using, such as Spanish or the 

company language.  

Aliases

Try this:
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The conversions can be done on the entire list of variables and units or just on a select few. In the 

example below, the company only wants to use aliases for a few of the variable names so that 

their maps closer resemble terms used in the company.

Once your alias Excel file is complete, draw your map in eVSM or open an existing map. Open 

up the NUM by clicking the button in the eVSM toolbar.   

Click on the “Import 

Alias Names” button 

in the NUM.

NUM
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Locate the file on your computer and open 

it. A dialog box will appear asking which 

worksheet you would like to use. This 

example will start with the German 

worksheet. 

Once you hit “OK,” the variables and units 

in the map will be changed to whatever was 

listed as the Alias. The map below shows 

the updated terms.

If you would like to switch back to the default eVSM names, open up the NUM and turn the 

Alias Mode off.

Process

A0010

Durchlaufzeit 
der activitat

Day0

Process

A0020

1

SecAuto

Menge Pro 
Zyclus

Item1

Zycluszeit Secx.xx

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0030

Type

Bestand Itemxx

DayAuto

Process

A0040

1

SecAuto

Menge Pro 
Zyclus

Item1

Zycluszeit Secx.xx

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

P P

P

P
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To use a different set of aliases, copy the map to a new page (except for the NUM) and drag out a 

new NUM. Import the same data file as before but use the Company Language worksheet instead. 

Now, the map shows terms that are used by the company.

Process

A0020

Activity Lead 
Time

Day0

Process

A0030

1

Cycle Quantity Item1

Machine Cycle 
Time

Secx.xx

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0040

Type

Inventory Itemxx

Process

A0050

1

Cycle Quantity Item1

Machine Cycle 
Time

Secx.xx

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

P P

P

P
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Adding a new variable

If you want to add in a new variable with an Alias, click on the “New Name” button in the NUM.

Fill in the Name and then the Name Alias. 

Note that the Name will be used when the 

Alias Mode is off and the Name Alias will 

be used when the Alias Mode is on. 

Now that the name is added to the NUM, it 

can be added to the map and it will change 

when the Alias Mode is on or off.
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3. Sequence

Set tag defaults that are used for auto-numbering shapes as they 

are dropped on the page.

First select the activity shapes using the shift key and in the 

CORRECT sequence and then click this button to create sequence 

arrows. This can be done a few shapes at a time. Note that the 

'Check' section in the toolbar does have a hide/show for sequence 

arrows. No sequence arrow loops are allowed.

Many of the calculations on the value stream map rely on the process sequence. This is defined 

on the map by using tag sequence arrows. 

Tags

Sequence

Identifies each unique path through the value stream (via sequence 

arrows) and adds path ID’s to steps.

Assigns tags in the order provided by sequence arrows.

Auto Path

Auto Tag

Auto Pipe Select the activity from which to originate the pipe arrows, then 

hold down the shift key and select one or more activities to pipe to.

Overview

Auto Pipe – Many to One Select the activity to be at the head of the pipe arrow(s), then hold 

down the shift key and select or more activities to pipe from. 

Select the source activity and using the shift key, select all 

downstream activities to connect the source to with tag sequence 

arrows. This button is located in the dropdown of the Sequence 

button.

Using the shift key select the source activities from which to 

originate tag sequence arrows, to a single downstream activity 

(the final shape you select while still holding down the shift key). 

This button is located in the dropdown of the Sequence button.

Seq One to Many

Seq Many to One 
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Same Paths 

All Paths

Please select shapes before clicking the “Same Paths” button. This will 

highlight the common paths that pass through ALL of the selected shapes.

Please select shapes before clicking the “Same Paths” button. This will 

highlight ALL of the paths that pass through all of the selected shapes.

Process A Process B

15CT Min 20CT Min

15
Accumulative 

Time
Min 45

Accumulative 
Time

Min

A0320
A0330

A0340

Transport 
Time

Min10

Managed Equation

Accumulated Time =

ST(CT;Min;0;APPLY)

  + ST(Transport Time;Min;0;APPLY)

    + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

Sequence

Sequence

To attach tag sequence arrows to tags, select a series of tags (or activities) in the correct 

sequence and then click the Sequence button in the toolbar.

The Tag Seq Arrow is used with Managed Equations and allows you to perform upstream and 

downstream calculations. This example shows how Accumulative Time can be calculated along 

the value stream with the use of Tag Seq Arrows.

Try this:

1. Select the shapes in the correct order using the SHIFT key. 

2. Click the Sequence button in the toolbar to automatically create sequence arrows to the shapes. 

If these shapes do not already have tags, using the Sequence button after having selected them in 

order will automatically attach tags to each shape.  

A0350 A0360 A0370

Process A Process A Process A
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A quick way to tag activities in order of the sequence arrows is to use the eVSM Auto Tag 

button.

AutoTag

Auto Tag

The Auto Tag function works by re-tagging the whole map, so it disregards what you want as the 

“Next Value” in the Tag and Paths form.  It orders the shapes by tag sequence arrows and then z-

order (for un-sequenced rows). Then, it goes through the sequence, and it increments each tag by 

the user-assigned interval (in the Tag and Paths form), with numbers starting at 0010 for each 

letter prefix.

Tag numbers can also be named manually by double-clicking to edit the text. However, the name 

must be unique and must be one letter followed by four numbers.

Charts are generally plotted in alphanumeric tag sequence, and the AutoTag button does a great 

job to help charts plot in upstream to downstream sequence.

You can set preferences for activity tag numbering using the “Tags” form. 

To add or change an Operation Tag, first select the shapes you wish to attach a tag shape to. 

Click on the “Tags” button in the toolbar. After you  choose a tag prefix letter, next value, and 

increment value, click the “Add Tags” button.

Tags

Tags
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After your shapes have been sequenced, there is an option to automatically generate the path IDs 

for all the possible paths on the map based on the sequence arrows. After shapes have been 

sequenced using the “Sequence” button in the toolbar, click “Auto Path” in the toolbar. This will 

automatically give paths to the shapes in the order that they have been sequenced. 

Warning: AutoPath regenerates path numbers for all shapes connected by sequence arrows and 

without consideration of the current path number on these shapes.

Auto Path

Auto Path

Process A Process B

A0220 A0190

A0250 A0660

A0880

1. After shapes have been sequenced using the “Sequence” button in the toolbar, click “Auto 

Path” in the toolbar. This will automatically give path IDs to the shapes in the order that they 

have been sequenced. 

Try this:

Auto Path

#2

#2

#2

21
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P

The Path List is used to identify a path or paths that a center belongs to. The shape is glued 

above the top right corner of the shape.

The Path List Shape

An activity can belong to no paths, one or more, or all paths. The benefit of assigning path 

numbers to activities is that the associated activity variables (like NVA time) can be summed up 

across the map in a path specific sense. 

After you have run the “Auto Path” button, each Path List could look like the following:

#3

All

P

P

This center is only on path 2

The center is on all paths  

The center is on 3 different paths

Process

A0620

To find out what Paths a center is on, right-click on the Path List          which will pull up a menu 

to display all the path numbers for that center or the whole map. You can also hide or show all 

paths and perform various functions as shown. Each path will be separated by comma, unless 

there are paths in a range which are denoted by x:x.

P

The path numbers for this inventory 

have been made visible. This center 

is on five different paths, which are 

1, 3, 5, 6, and 7.

2

A0750

1,3,5:7

#5

Inventory Item2

Inventory
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If you have various paths on the map, and want to see the common paths that go through multiple 

centers, then use the Same Paths button in the toolbar. 

#5

Process A

A0700

#3

Process B

A0710

#4

Process C

A0720

#2

Process D

A0730

#3

Process E

A0740

You must first select which centers on the map you’d like to view the paths for. Hold down the 

SHIFT key if you want to select more than one center. In this example below, Process B and 

Process C are selected.

After the Same Paths button was clicked, Process B and Process C are highlighted, reminding 

you which centers were selected. Only the paths that go through both centers are highlighted, 

which are 3 and 4, shown in blue and red. 

3

3

3

3

4

4

4

4

To start a view with different centers, click the Clear button in the toolbar to clear all highlights. 

Alternatively, if you want to add centers to the original two you selected, just hold down the 

SHIFT key and select the new centers to add. Then click the Same Paths button again.

Clear

Lead 

Time

3:4

#2

View Same Paths

Same Paths 

Same Paths 

Show Paths on Center

Show Paths on All

Hide Paths on Center
Hide Paths on All
--------------------------------------------------
All Paths
--------------------------------------------------
Select Paths

Set Path From View

If you have a view of the paths that you would like to set into a 

Path Filter for a summary or chart, use the right-mouse option on 

the Path Filter and select “Set Path from View”. This was done for 

the example view above for paths 3 and 4.
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If you have various paths on the map, and want to see all of the paths that go through multiple 

centers, then use the All Paths button in the toolbar. In the example below, Process C and Process 

D were selected using the SHIFT key, and then the All Paths button was pressed. All of the paths 

are highlighted from Process C (1 and 2), and Process D (3).

View All Paths

The right-mouse option on the Path Filter of “Set Path from View” will work for this function as 

well. 

Highlight Path Arrows

If you have multiple paths highlighted, like the red, green, or blue boxes, you can view their path 

by highlighting the sequence arrows in the matching color. If you right-click on any of the 

highlighted path boxes, there is an option to “Highlight Path Arrows”. This has been done for 

path 4.

1:5

#5

Process A

A0130

3:5

#3

Process B

A0140

1:4

#4

Process C

A0150

Customer A

1,3

#2A0160

Customer B

2,4:5

#3A0170
5

5

Process D

A0180

3

3

3

3

4

4

4

4

5

5
5

5

1:4

#4

Process A

A0190

2:4

#3

Process B

A0200

1:2

#2

Process C

A0210
Customer A

1:2

#2A0220

Customer B

3:4

#2A0230
3

3

Process D

A0240

1
1

1

2

2

2

2

3

3
3

3

All Paths
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In the example Lead Time chart below, there are three paths, denoted by the bold numbers. If you 

right-click any of the path numbers, there are options to:

Highlight Path: Puts blue highlights on the centers for that particular path

Animate Path: Animates that particular path with a moving token

Show Path Alias: Brings up a form that shows the path name based on the Path Markers

Lead Time Summary
Day

0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5

A0020

A

A0030

B

A0050

E

1
4.00

A0020

A

A0040

D

A0050

E

2
5.00

A0020

A

A0060

C

A0050

E

3
4.50

Non Value Added

Legend

Path identification on ladder charts

Path Marker

xx

The Path Marker, found in the eVSM Sequence stencil, allows you to name paths by specific 

centers on the map. Glue the Path Marker to any glue point on a center and make sure a glue 

connection appears. Then double-click the marker to enter the marker name. Once you have 

attached Path Markers to the desired centers on the map, click the “AutoPath” button in the 

toolbar to update the path names. After adding Path Markers, the path names can be seen either 

in the Path Filter Manager or by hovering over path numbers on ladder charts (like lead time 

charts).

P

Process

A0060
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Path Filter List

The Path Filter List, found in the eVSM Sequence stencil, is used to filter summary or chart 

shapes by path(s). The default will be “all”, if no changes are made. 

By double-clicking on the Path Filter List, the Path Filter Manager will appear, allowing you to 

choose which paths to work with. Use the “Add” or “Remove” buttons to move the desired paths 

to the “Selected Paths” box.

If you have attached any 

Path Markers on the map, the 

path name will appear next 

to the path number.

This Search field allows you to find paths on the 

map based on the Path name (using Path Markers), 

center text names (typically green), and tags (like 

A0010), and will move them to the top of the list.

Use the “Highlight” button to show 

the paths in the “Selected Paths” 

box visually on the map. 

Lead 

Time

all

Transport Summary

Z0055 all

Total Transport 
Distance KmAuto
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This function allows you to automatically create pipe arrows from one center to many centers. 

Alternatively, you can create the pipe arrows from many centers to one center. The main use is 

for resource allocation. By adding pipe arrows you can determine which resources are used for 

which activities. 

Auto Pipe

Activity B

Activity C

A0070

A0080

Resource PT
Min
Item2

A0090

Resource PT
Min
Item3

Resource A

Try this:

1. To use this function, select the center from which to originate the pipe arrows then hold down 

the SHIFT key and select one or more centers to pipe to. Resource A was selected and then while 

holding the SHIFT key, Activity B and C were selected. 

2. Click the “Auto Pipe” button to automatically create pipe arrows from one activity to many 

activities. 

3. Fill in the pipe arrow data of Resource Process Time which shows that Resource A is used for 

2 minutes per item for Activity B and 5 minutes per item for Activity C. 

A

B

C

Auto Pipe – Many to One

Alternately, you can use the Auto Pipe – Many to One 

button, which is in the dropdown menu of the Auto Pipe 

button, to create pipe arrows from multiple Resources 

into an Activity. 

Activity C

A0100

A0110

Resource A

A

A0120

Resource A

C

B
Resource PT

Min
Item2

Resource PT
Min
Item3

Auto Pipe
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4. Validate

Overview

Must do this before using the Solve button. Performs numerous 

checks on the model and reports back any problems.

A visibility toggle switch for tag sequence arrows. Generally 

recommended that you work with these visible so you can fix 

sequence arrows as you modify the map.

Removes various highlighter shapes used for glue display or 

problems displayed by the software.

This section contains checking functions to validate the model ahead of analysis. 

Check

Show Seq.

Clear

Show Pipes Just a visibility toggle switch for pipe arrows. Generally 

recommended that you work with these while visible so you can 

fix pipe arrows as you modify the map.

44



Copyright © 2016 The eVSM Group, All Rights Reserved 

Missing Data: Data Shapes which are not properly associated to Rowmaker Shapes (via gluing) 

will be missed in the data transfer and are highlighted. 

Missing Units Converter: If a variable is used with more then one unit (eg. Cycle time in 

minutes and seconds), then a units conversion factor must be provided. Standard time units (e.g. 

sec, min, hr, day) are already included in the time center and don’t require a units converter. 

The Tag Sequence Arrow visibility can be set with the switch in the eVSM Toolbar:

The Tag Pipe Arrow visibility can be set with the switch in the eVSM Toolbar:

Use the button below to clear any highlighters off of the map:

Show Seq.

Clear

The Check function highlights some common problems on the map with a red circle and checks 

the model. To run, click this toolbar button:

Problems fixed by the Check function include:

1. Removes hidden data shapes: sometimes when using copy/paste, multiple copies are 

created and duplicates are hidden under visible data shapes. Finding and removing these 

can be tedious, so ‘Check’ automatically deletes such duplicates.

2. Automatically glues data shapes and arrows based on proximity.

3 Works around the Visio glue limitation of 10+ shapes.

Check

Check

Mold Handles

55Cycle Time Secs

2.5
Changeover 

Time
Hrs

22Defects ppm

4Operators Staff

96Yield %

85Uptime %

Mold Handles

55Cycle Time Secs

2.5
Changeover 

Time
Hrs

22Defects ppm

4Operators Staff

96Yield %

85Uptime %

Before After

Show Pipes
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5. Calculate

Overview

Writes data out to excel, performs any calculations specified via 

managed equations and displays results back on the map. Also updates 

gadgets and charts on the map.

This section links the map to an underlying Excel spreadsheet to perform lean calculations with 

the results displayed back on the map. 

Solve

Variational Solve Calculates values using variational data.

Tag Operation VA NVA Data Data Data Data

v
a
lu

e
 a

d
d

e
d

n
o

n
 v

a
lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n
c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

Visio

The eVSM Solve button in the toolbar provides bi-directional transfer of information between the 

map and a spreadsheet. When the button is clicked for the first time in a map, eVSM 

automatically creates a new Excel file and puts it in the same folder the Visio file is saved in. 

The function only operates on the current map page. All blue “Auto fields” will calculate to the 

appropriate values on the map.

The eVSM Calculator

Solve

all

Time Summary

Z0010

Takt Time
Sec
Item

Auto

Total Value 
Added

MinAuto

Lead Time DayAuto

Value Added 
Percent

%Auto

all

Time Summary

Z0050

Takt Time Min4.20

Total Value 
Added

Min1288

Lead Time Day12.60

Value Added 
Percent

%24.34
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Variational Data

eVSM now supports simple means of specifying variation in data for selected input values and 

creates variational output for designated calculated values. The example below pulled from a 

Quick Manufacturing example map. Note that this functionality does not with the Quick 

Transactional Pro stencil. 

1. Drag out a Normal Distribution icon from the eVSM Data and glue to the Cycle Time 

variable. Make sure a red glue connection appears to make sure it is glued properly.

2. The mean and standard deviation 

for the activity’s cycle time was 

entered.

Try this:

3. We want to see what effect this will have on the Lead 

Time. The Output Variation icon from the main stencil 

has been glued to the Lead Time of the Summary Center. 

4. The Variational Solve button is selected and the user 

selects ‘75’ solve iterations. Each solve uses a random 

number generator to “pick” a value from each variational 

input. It also creates a sample output for each designated 

out variable. This is a simple type of Monte Carlo 

analysis.

Var Solve

5. Right-click on the Output Variation shape and select “Plot 

Output Distribution”.

6. The Lead Time has been plotted with the various confidence 

levels.

Assemble

A0070

1.00

Sec600.00

Qty Per Cycle Item1

Cycle Time Min10

Capacity
Item
Day

84.00

410

Time Summary

Z0080

Takt Time
Sec
Item

2520.00

Total Value 
Added

Min15.00

Lead Time Day2.52

Value Added 
Percent

%0.71

Process Time 
Per Unit

Sec
Item

900.00

Normal Distribution

5
0

%
 <

 2
.5

2

8
5

%
 <

 2
.5

2

9
5

%
 <

 2
.5

2

9
9

%
 <

 2
.5

3

P

P
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1. Connect a Variation Percentile shape from the eVSM Data stencil to 

the target variable (lead time in the example below), and set it to 95.

2. Create a managed equation (refer to the managed equations section) 

that equates lead time to the sum of the cycle time.

3. Press the Solve button in the toolbar and note that the lead time 

solves to 63.16. Without the percentile specification the answer 

would have been 50.

Variation Percentile Shape

Process Process
Summary

A0020 A0030 A0040

Cycle Time Min20 Cycle Time Min30

Lead Time Min63.16

820

95

The Variation Percentile shape, when attached to a variable that is calculated via an equation, 

provides a way to access percentile values for any terms in the equation that have an associated 

distribution. In the example below, lets say we want to calculate a lead time that will not be 

exceeded 95% of the time.

Try this:

Solve
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Data Source and Data Target is used to link the data from different shapes or pages. In this 

example, the main map has an Assembly station that is actually a multi-machine. The data from 

the Multi-Station Wizard will be linked to the main map for the center.

The main map is below, with the multi-machine beneath it.

Source and Target

M1

Qty Per 
Cycle_M

Item1

Cycle Time_M Min4

Cycle Time Per Item Min2.00

Capacity Per Day Item240.00

Stations_M Stn2

Activity 
Time_M

Hr
Day

10

OEE 
Percent_M

%80

CT Capacity Per Day Item300.00

QPC Contributor ItSq300.00

All Stations Time Hr
Day20.00

A0100

M2

Qty Per 
Cycle_M

Item1

Cycle Time_M Min2

Cycle Time Per Item Min2.00

Capacity Per Day Item324.00

Stations_M Stn1

Activity 
Time_M

Hr
Day

12

OEE 
Percent_M

%90

CT Capacity Per Day Item360.00

QPC Contributor ItSq360.00

All Stations Time Hr
Day12.00

A0110

M3

Qty Per 
Cycle_M

Item1

Cycle Time_M Min6

Cycle Time Per Item Min6.00

Capacity Per Day Item119.00

Stations_M Stn1

Activity 
Time_M

Hr
Day

14

OEE 
Percent_M

%85

CT Capacity Per Day Item140.00

QPC Contributor ItSq140.00

All Stations Time Hr
Day14.00

A0120

Multiple Station Equiv.

Stations Stn4.00

MS Capacity 
Per Day

Item683.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item800.00

MS Cycle Time Per 
Item Min0.86

OEE Percent %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

Z0050

123

A0010

Customer

Customer 
Demand

Item
Day

7000

Share % %100

Effective 
Demand

Item
Week

Auto

Atlas

A0030

Activity Lead 
Time

Day0

A0040

Blanks

Inventory Item7500

DayAuto

Sharpen

A0050

1

SecAuto

Qty Per Cycle Item5

Cycle Time Min1

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0070

Moulded Blanks

Inventory Item3000

DayAuto

Assemble

A0080

1

SecAuto

Qty Per Cycle Item10

Cycle Time Sec2

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

A0090

Scissors

Inventory Item5000

DayAuto

Stations Stn1

P P P P
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The Assemble activity center on the main map is represented by the equivalent multi-machine. 

The goal is to populate the input fields for the Assembly activity from calculated values on the 

multi-machine map. The Multi Station Wizard has been purposely designed so that it calculates 

the values that the activity on the main map needs AND has the SAME variable names (Cycle 

Time, Stations, etc.). In the special case where source and target variable names are identical, 

source and target identifiers can be glued to the center shape as shown below.

1. In the same file as your main map page, create a new page. Click the Open button and use 

the Mfg Multi Station Wizard to create the example map shown on the previous page. After 

you have created it, name the page to MS. Drag out the “Data Source” marker from the 

eVSM Data stencil and glue to the Multi Station Summary Center. Note that source 

variables can be located on the same page as the target variable or on another page in the 

same file.  Enter an ID, like 123 which will be used for the target marker as well.

Linking Variables with the Same Name: Try This

Multiple Station Equiv.

Stations Stn4.00

MS Capacity 
Per Day

Item683.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item800.00

MS Cycle Time Per 
Item Min0.86

OEE %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

Z0010

123

P
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Note that the default setting for the target variable is set to sum all of the source variables. You 

can right-click on the target and change sum to average, max, or min.

2. Go back to the main map page and drag out a “Data Target” marker and glue to the side of 

the Activity Center. Enter 123 for the ID. In order for the calculation to be correct, the first 

five variables from the multi-station summary center MUST be on the Activity Center. If 

they are not, you will have to manually drag them out from the Quick stencil and glue to 

the Activity Center.

3. If the source and target variables are on separate pages, the page where your target variable 

is must be linked to the source page. Make sure each page in your Visio File has a 

memorable name in order to differentiate pages when setting the scope. 

Assemble

Qty Per Cycle Item1

Cycle Time Minx.xx

1

A0040

MinAuto

123

Stations Stn1

OEE Percent %x.xx

Activity Time
Hr

Day
x.xx

P
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6. On the main map page, click the “Solve” button in the toolbar. See how the target variable 

is able to access the source variable values automatically as part of the solve as seen in the 

Assemble activity center. You must have a value entered in each of the x.xx fields, even if 

it is 0, or the solve function won’t run. 

Notice how the Assemble activity matches the 

values of the multi-station equivalent machine 

summary center.

Solve

Assemble

1

123

A0010

Stations Stn4.00

Activity Time
Hr

Day
11.50

OEE %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

4.  In this example, go to the main map page where your target is and click the NUM button in 

the toolbar to open the dialog box to set the page scope. 

5. Click “Source/Target Pages” at the 

bottom of the box and select the page 

on which your source marker is 

located. 

NUM

P
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Linking Variables with Different Names/Units

In the general case when you are trying to link values of variables with different names, you 

should glue the source/target markers onto the side of the variable as opposed to the whole 

center.

Activity

Qty Per Cycle Item1

1

A0050

CT Hr0.13 1

Multiple Station Equiv.

Stations Stn4.00

MS Capacity 
Per Day

Item198.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item348.00

MS Cycle Time Per 
Item Min1.98

OEE %56.90

Qty Per Cycle Item1.00

Cycle Time Min7.93

Z0010

1

60

Hr

Min

If the units are not the same, there must be compatible 

unit converters, like Min to Hr, located on the source 

page for the solve function to convert the value. If the 

units are not compatible and you try to solve, an eVSM 

Warning message will appear telling you to create a unit 

converter. See the example below which shows different 

variable names and units, but was able to link the values 

because of the correct unit converter.

Target Page

Source Page

P

P
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eVSM has an XL Report builder that will export the tag, operation, 

type, and custom variables one directionally to Excel. 

XL

Report

2. Right-click on the XL Report shape and select “Edit Report Data”.

3. Enter a Report Name which will 

be the page name in the Excel 

file. 

4. Click “Add” to create a category 

header. 

5. Click “Add” to select the 

variables to the export to the XL 

Report. 

6. Select the desired variable from the dropdown 

menu.

7. If you don’t want the default unit, uncheck this 

box and change the units manually. 

XL Reports

Try this:

1. After your map has been solved, drag out the XL Report icon from 

the eVSM Kaizen stencil. 
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Tag Operation Type Time

C
yc

le
 T

im
e

C
u

st
o

m
e

r 
D

e
m

a
n

d

Min Item/Wk

A0010 Prepare 5

A0010_A0020

A0020 Paint 10

A0020_A0030

A0030 Package 8

A0030_A0040

A0040 Customer 100

8. After you have finished adding the desired variables, right-click on the XL Report shape and 

select “Run Report”.

XL

Report

Edit Report Data

Run Report
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6. Visualize

Overview

Allows management of gadget families providing geometric views of key 

numbers of the map with color coding, scale factors and hide/show.

Updates all the geometric gadgets based on the current map values.

The view capability simplifies maps with better utilization of map space. Also allows the 

visualization of the numbers using gadgets and charts. 

Gadgets

Update

Views Opens a window for modifying variable visibility settings for the map.

Lets you hide Quick Centers on your map by having their corresponding 

rows in Excel hidden. This lets you keep as much data as you want in 

Excel, and use Excel's built-in filtering tools to control visibility in eVSM.

You can make a view permanent using the 'Copy Filter View' button, and 

make calculations on your map using that view.

Filter
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To prevent maps from looking crowded, there are a large number of variables in eVSM that are 

hidden. The views capability allows you to manage which variables you would like to be hidden/

visible on the map. 
Views

Hiding & Showing Variables

 There are two options at the bottom of the menu for quick views:

1. Default Variable Visibility: Reverts back to how the centers and variables look when dragged 

out from the stencil.

2. Hide Auto: Hides all blue calculated variables.

Try this:

1. Click the Views button in the toolbar.

2. This will open the form below which allows you to manage the visibility of variables on the 

map. The dark gray boxes indicate the hidden variables on the map, and white boxes represent 

that the visible variables on the map.

3. Check the boxes of some variables that are currently grayed out.

4. Click OK and the changes will apply to all centers on the map.
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Any data on the map can be linked to visual gadgets that change in size and color with change in 

the data. Some gadget types are shown below:

Sq. 
Area 

Gadget

Tr. Area 
Gadget

Slider 
Percent 
Gadget

Arc 
Angle 

Gadget

Line Tk 
Gadget

Bar 
Height 
Gadget

Curve Tk 
Gadget

Each gadget has exactly one size parameter that can be tied to a data value on the map. Here’s 

the typical means used to apply and manipulate gadgets:

1. Drag out the gadget from the eVSM Visuals stencil and position it near the data value with 

which it will be associated (in this case the “Cycle Time”). In this example the Bar Height 

Gadget is being used.

Bar Height 
Gadget

Using Gadgets to Visualize Data

Process

Cycle Time Min2

2. This system shape will be automatically dropped on the page the first time a gadget is used. 

If you copy a map to a new page make sure you also copy this shape because it is used to 

hold gadget data for the map.

3. Select the gadget, drag and glue the gadget’s yellow flying connector to the side of the 

NVU data shape (avoid gluing to the top or bottom of the data shape).

Process

Cycle Time Min2

Try this:
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4. Right-click on the gadget and use the “Activate Gadget” option to create a new gadget 

collection. The collection name will be “Bar_Cycle Time”. The name is created from the 

gadget type and the data variable name.

A gadget can only belong to one collection. Each collection can only have a single type 

(eg. “Bar”) of gadget.

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

5. You can change gadget scale factors and color code them by modifying the properties of 

the associated Gadget Collection. You can easily create additional gadgets tied to other 

instances of the same data on the map. Just click on the gadget and use the right mouse 

button to select “Create Gadgets By Example” to create the gadget for Process B below.

Process A

Cycle Time Min2

6. Note that the new gadget is automatically positioned, scaled and put into the same 

“Bar_Cycle Time” collection. If you do not wish to have new gadgets created for the whole 

map than select the original gadget, then sub-select an area of the map before using the 

“Create Gadgets By Example” menu.

Process A

Cycle Time Min2

Process B

Cycle Time Min6

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

Process B

Cycle Time Min6
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7. To modify a gadgets scale factor or to color code it, you need to change the properties of its 

associated collection.  Right mouse click on the gadget and select “Manage Gadget 

Collections,” or click the Gadgets button in the toolbar.

Gadgets

You can color code 

the gadget fill and 

font colors based on 

the value of the data 

to which the gadget 

is glued. You can 

also simply “inherit” 

the color from the 

data shape or assign a 

color to a gadget 

manually.

You can modify the scale 

factor for a collection that 

controls gadget size in 

relation to data value. Use 

the Apply button to see the 

new  gadget sizes on the map 

before exiting the form.

To hide or show gadgets in a 

collection, first select the 

collection from a list, then 

click this button.

Note: the collection list has a 

column indicating visibility 

status.
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§ Gadgets have a single size parameter that will scale to the data value in which a gadget is 

glued via the flying yellow connector.

§ Gadgets are typically glued to NVU, VA or NVA shapes. When gadgets in a collection are 

glued to data shapes with different units, Units Converters are needed on the map to 

compute the correct scale factors.

§ Gadgets have to belong to a collection. They can be put in a collection using the Activate 

Gadget command or by transferring them into a collection via the Manage Gadgets form.

§ Gadget scale factors and color coding can be controlled via the Manage Gadgets form.

§ An easy way to create a gadget “set” after creating a first gadget is to use the Create 

Gadgets By Example in the right mouse button menu.

§ The Visible switch on the Manage Gadgets form is very useful in showing different 

metrics on the map in a presentation environment.

§ See the “Examples” section on the eVSM help site (www.evsm.com/help) for usage 

examples of the different gadget types.

§ A starter set of gadgets is provided with eVSM. Additional gadgets can be requested by 

contacting support@evsm.com.

Gadget Tips:
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Image/Text/Value/Unit Gadget

There are three gadgets that can be used to visualize hidden data in shapes on the map.

Image Text Gadget:

Text and Value Unit Gadget:

Text and Value Gadget:

Name Value Unit=

xx Unitabc =

xxabc =

For example, if you have kaizen bursts with various properties assigned, you can visually see 

them with the combination of image, text, value and units. You can customize the font, color, and  

size of the gadget to apply map wide. The instructions below will explain how to visualize the 

Impact number with the Text and Value Gadget.

Problem

001

xxabc =

1. The kaizen burst must have the properties you want to visualize already 

assigned. From the eVSM Visuals stencil, drag out the Text and Value 

Gadget and place it near the starburst.

2. Select the gadget, drag the yellow flying connector, and 

glue it to a glue connection along the edges of the starburst. 

Make sure a glue connection appears.

Problem

001

3. To change the “abc” to “Impact”, click the abc text box, and click the “F2” button on your 

keyboard to edit the text. This is where you can also customize the font size, color, and 

positioning as the standard.
xxImpact =
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4. Right-click the gadget and select “Activate Gadget”. 

Problem

001

4Impact =

5. Select “Impact” from the list. 

Once you click OK, the Impact number from the kaizen will be inputted into the gadget.

6. To apply this gadget to the rest of the kaizens on the map, right-click the gadget and select 

“Create Gadgets by Example”. You can manually move the gadgets, otherwise they will be 

created in the same location in relation to the starburst as the original one.

7. If you change any of the values shown by gadgets, you can click the “Update” button in the 

eVSM toolbar to update all gadget values. 
Update
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Conditional Color Gadget

Conditional Color 
Gadget

The Conditional Color Gadget allows the ability to color code values 

based on value ranges. 

Process

A0020

1.00

Sec15.00

Qty Per Cycle Item1

Cycle Time Sec15

OEE Percent %95.00

P

Scrap Percent %5

1. Drag out the Conditional Color Gadget from the eVSM Visuals stencil.

2. Click on the gadget, and use the yellow flying glue 

connector to glue to any side of a variable. Make sure a red 

glue connections appear, confirming that it is glued.

3. Right-click the gadget and click “Activate Gadget” if 

there is only one on the map, or select “Create Gadgets by 

Example” if you would like to add a gadget for that 

variable map wide. 

4. Click the Gadgets button in the toolbar. Gadgets

5. Select the Gadget collection.

6. Click the “Color Code…” button.
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7. Select “Based on Value Ranges(s).

8. Fill in the desired ranges 

with the fill color.

Process

A0030

1.00

Sec15.00

Qty Per Cycle Item1

Cycle Time Sec15

OEE Percent %95.00

P

Scrap Percent %5

9. The Gadget will change to the color chosen. If values 

change, so will the gadget color after Solve is run. 
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Cycle Time Min6

Enable Flying Connector

Name Help

________________________

Select all with Name

Select all with Name on Path

Edit Name.. (Cycle Time)

Edit Unit.. (Min)

Plot Name Values

Plot Distribution Values

There is now the option to plot the name values for all variables on the map. 

Plot Name Value

1. Drag out three activity centers and fill in the values.

2. Right-click on Cycle Time and select “Plot Name Values” in the menu.

Wash

Qty Per Cycle Item1

Cycle Time Min4

1

A0030

MinAuto

Drill

Qty Per Cycle Item1

Cycle Time Min2

1

A0040

MinAuto

Inspect

Qty Per Cycle Item1

1

A0050

MinAuto

VSM - Cycle Time

M
in

0

1

2

3

4

5

6

A080

D
ril
l

A090

W
as

h

A100

In
sp

ec
t

Cycle Time

Legend

Try This:

P P P
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Plotting VSM Charts 

XY Charts (Combination & Pareto Charts) - Any numeric data available for analysis in eVSM 

can be plotted on a chart such as this:

Cross Dock

Assemble

30Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Test

10Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Ship

500Defects ppm

Drill

20Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Sharpen

75Cycle Time Secs

15
Changeover 

Time
Hrs

1Operators Staff

50Batch Size Pairs

Mold Handles

53Cycle Time Secs

2
Changeover 

Time
Hrs

2Operators Staff

50Batch Size Pairs

38500

Scissors

Pairs 27000

Scissors

Pairs 31000

Scissors

Pairs 7000

Scissors

Pairs 5000

Scissors

Pairs75000

Scissors

Pairs

ATLAS 

Warehouse

1

Frequency

Per 
Week

1

Frequency

Per 
Week

MRP

Production

Control

Forecast 30 Days
Weekly Order

Daily

Daily

130.00 Secs

4.17 Days

75.00 Secs

2.14 Days

20.00 Secs

1.50 Days

30.00 Secs

1.72 Days

10.00 Secs

0.39 Days 0.28 Days

Weekly Schedule

Summary

18000Daily Demand Pairs

10.19
Production 
Lead Time

Days

265.00
Processing 

Time
Secs

Daily Ship Schedule

5

Wks

Days

2

Days

Shifts

7.5

Shifts

Hrs

60

Hrs

Mins

60

Mins

Secs

Plant Summary

2.00
No of Shifts 

per Day
Shifts

5.00
No of Work 

Days per Wk
Days

15.00
Production Hrs 

per Day
Hrs

500.00Defects ppm

62.50Raw Materials Hrs

4.17
Finished 
Goods

Hrs

86.25
Work in 

Progress
Hrs

67Takt Time Secs

A10 A20 A30 A40 A50 A60

A70

B10

B20

ACME Scissors

Current State Chart

Maker

Before creating a chart, you must ensure that the data to be plotted is:

- Contained in eVSM data shapes

- The data shapes are glued to the parent rowmaker shapes

- Rowmaker shapes are tagged with Operation Tags

Hint: Use the Glue Check and Excel Check buttons in the eVSM toolbar to verify

1. Drag out the XY Chart icon from the stencil, and place it anywhere on the map. 

2. Set up chart parameters and click “Plot Chart” command in the right mouse button menu.

XY Chart
XY 

Chart

Edit Chart Data

Plot Chart

Create Spreadsheet

Right mouse click on the shape and 

select the “Edit Chart Data” command.

Set data filters

Enter chart title Select Y-axis 

units

Optional chart 

description

Variables will be 

plotted in sequence 

shown here. Use Up 

Down buttons to 

change sequence

Try this:

Cycle Time - Takt Time Chart

S
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s
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A010

M
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d 
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A030

D
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l

A040

A
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bl
e

A050

Tes
t

Cycle Time

Takt Time

69



Copyright © 2016 The eVSM Group, All Rights Reserved 

Options for Chart Variables:

3. Click the Plot Chart command in the right mouse button menu.

Notes:

§ Each eVSM Chart is a group of simple shapes. Avoid ungrouping these as this may displace 

some of the shapes.

§ Chart will update automatically when the Calculator is run. To update the chart manually, 

use the “Update command in” the chart’s right mouse button menu.

Edit Chart Data

Plot Chart

Create Spreadsheet

Set a default value for non-

existent plot points

Select Variables to plot

Select Display Type

Enter Tag number for 

single tag data plot

Set color of fill or lines

Sales Milestones

90Order Approved Days

10
Order Shipped 
to Customer

Days

0Order Accepted Days

A003
0

Manufacturing 
Milestones

80
Manufacturing 

Begins
Days

30
Inspection 
Complete

Days

15
Manufacturing 

Complete
Days

A004
0

Milestone Charts

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

1. Get data ready in this format:

Try this:
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2. Drag out the Milestone Chart icon and click the “Edit” 

command in its right mouse button menu.

3. Complete the form:

4. Plot chart.

5. Use the “Update..” command in the chart’s right mouse button menu to update the chart 

when the data changes.

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

Update Milestone Tag Chart

Milestone 

Chart

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Milestone 

Chart

Milestone 
Chart

Cumulative Bar Charts

The Cumulative Bar Chart allows you to visualize the phases of a value stream on a timeline.

Order Fulfillment Timeline

Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

1. Get data ready in this format:

2. Drag out the Cumulative Bar Chart icon 

and click the “Edit” command in its right 

mouse button menu.

Cumulative 

Bar Chart
Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

Cumulative 
Bar Chart

Order Fulfillment 
Timeline

1Process Order Days

8Order Approval Days

3Scheduling Days

15Wait for Mfg Days

10Manufacturing Days

1
Wait for 
Delivery

Days

2Delivery Days

B070
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4. Plot the chart:

5. The chart will update automatically when the Calculator is run. To update the chart 

manually, use the Update command in the chart’s right mouse button menu.

Order Fulfillment Timeline
Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

Update Cumulative Tag Chart

Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

Ladder Charts

The Ladder Chart shape allows you to create timeline and operator balance charts such as the 

following:

Operator Balance Chart
Min

0 2 4 6 8 10 12 14 16

A010De-burr 

Casting

Operator1

A020Assembl

e Lining

A030Install 

switch

Operator2

A040Solder 

Wiring

Operator3

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010De-

burr 

Casting

A020Asse

mble 

Lining

A030Insta

ll switch

A040Sold

er Wiring

Non Value Added Value Added

3. Complete the form:
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Update Chart

We will plot a Timeline Ladder for the VA/NVA times from this VSM.

Solder Wiring

13Operator3 Min

A040

9 Min

4 Min

De-burr Casting Assemble Lining Install switch

3Operator1 Min 12Operator1 Min 7Operator2 Min

A010 A020 A030

2 Min

1 Min

9 Min

3 Min

4 Min

3 Min

Ladder 
Chart

Ladder 

Chart

Ladder 

Chart

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010

De-burr 

Casting

A020

Assemble 

Lining

A030

Install 

switch

A040

Solder 

Wiring

Non Value Added Value Added

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet

Try this:

1. Drag out the Ladder Chart icon and click the “Edit” command in its right mouse button 

menu.

3. Plot chart:

4. The chart will update automatically when the Calculator is run. To update the chart, 

manually, use the “Update Chart” command in the chart’s right mouse button menu.

2. Complete the form:

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet
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Filtering Views

The Filter button in the eVSM toolbar lets you hide Quick Centers on your map by having their 

corresponding rows in Excel hidden. This lets you keep as much data as you want in Excel, and 

use Excel's built-in filtering tools to control visibility in eVSM.
Filter

The corresponding page name in Excel must be the page name you are using in Visio + “_ID”. So 

if the page name in Visio was “VSM”, then the Excel page name needs to be “VSM_ID”. 

The data must be started on row 2, with headers on row 1, and the first column named “ID” to 

identify the centers. Below is an example of the Excel sheet with the corresponding ID on the 

Activity Center. 

ID TxtA

A0010 1

Activity Lead 
Time

Day7

Process

Configuring Excel

Configuring Visio

1. In order to specify the Quick Centers from Visio to Excel, an ID shape must be glued to it. 

From the “eVSM Data” stencil, drag out the “Long NVU” shape and glue it to the center. 

Name Unitx.xx

Process

A0020 P

Activity Lead 
Time

Day0
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2. Then click the NUM button in the toolbar to create an ID variable. NUM

3. Click the “New Unit” 

button.

4. Enter the unit name of 

“Txt” and then click OK.

5. Click the “New Name” 

button.
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ID TxtA

6. Enter the Name “ID”.

7. Select the new unit “Txt” that was created. Then 

click OK.

Name Unitx.xx

Process

A0010 P

Activity Lead 
Time

Day0

8. Double-click on the Name field, and select the newly created “ID” NVU. Then click OK.

Process

A0020 P

Activity Lead 
Time

Day0

9. In the x.xx field, type the unique ID for that center. 
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10. Once you have attached IDs to the desired Quick Centers, and hidden the rows in Excel for 

the view you want, then go back to the Visio file and click the “Filter” button. 
Filter

11. Once that view of the centers is configured on the page, a message will appear asking to close 

the filter view, or make a copy of that filter view to another page so you can make calculations 

on your map using that view.
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7. Improve

Overview

Allows addition of improvement ideas on the map supported by Impact matrix, Risk matrix, and 

Kaizen Report. 

Map Copy Allows a map to be copied to another page in the file.

Kaizen Properties

Kaizen Export

Kaizen Import

Renumber Kaizens

Select the kaizen/project property set for the map.

Creates an Excel spreadsheet of Kaizens with their property data.

Reads an Excel spreadsheet of Kaizens with property data back to 

eVSM.

Renumber the Kaizen shapes in the order they are selected. 

Numbering starts at 001, and any un-selected Kaizen shapes get 

numbered after the selected Kaizen shapes.

Kaizen Standardization

You can now standardize your kaizen custom properties by selecting the set of data for the 

Kaizens on the map. The Kaizen Properties button in the toolbar will bring up a form allowing 

you to select which properties to standardize on for the map. 
Kaizen Properties
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The Kaizen Export toolbar button scans the map for all Kaizen shapes (Starbursts) and exports 

custom properties associated with the shapes to Excel spreadsheets (Pagename_Kaizen). This 

Excel spreadsheet will show the connectivity of Kaizen starbursts with activities and other 

Kaizen starbursts. If you want to edit the custom properties data via Excel, you may do so and 

import the data back into eVSM using the Kaizen Import button.

Kaizen 
Starburst

Problem

123

Generating Kaizen Report

Try this:

1. Open a blank Visio drawing page with the Quick Manufacturing stencil. 

2. Drag out an Activity Center.

Reduce 

Changeover 

Times

001

More Frequent 

Deliveries

002

Kaizen 
Starburst

Kaizen ExportKaizen Import

Problems can be documented using Kaizen starbursts, which 

can now be connected to activities as well as other Kaizens.

4. Click the Kaizen Properties button in the toolbar to bring up the form to see which properties 

are available as well as a description of each.

Check or uncheck the boxes to add/

remove properties to the standard 

custom properties list when editing 

each kaizen on the map. 

Kaizen Properties

Double-click the word “Visible” to 

toggle all of the properties on or off.

3. Drag out two Kaizen Starbursts from the eVSM Kaizen stencil. Edit the descriptions to 

“Reduce Changeover Times” and “More Frequent Deliveries”.
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Kaizen Impact Matrix

Try this:

5. Click the Kaizen Export button in the toolbar to create a Kaizen Report in Excel. Kaizen Export

ID Kaizen Process Step Data Data Data Data Data Data Data Data Data Data Data Data Data
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Uni t Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit

1 Reduce Changeover Times Process 1 1 1 1

2 Make Frequent Del iveries Process 1 1 1 1

The Kaizen impact matrix was introduced in a late version of v5 and uses the “Impact” and “Ease 

of Implementation” custom properties of kaizen starbursts to plot an impact matrix. The goal of 

the matrix is to help select projects for implementation to improve the value stream.

The mini-Kaizens in the matrix copy the custom properties of the originals (map Kaizens). They 

are numbered based on the ID’s of the Kaizens on the map (ID’s are circles glued to the top left 

of the kaizen shapes). A right-mouse click on any of the mini-Kaizens allows for selection and 

highlighting of the parent map kaizen. 

6

Highlight Kaizen

1. Change the Impact and Ease of Implementation properties of each starburst by right-clicking 

the starburst and selecting “Edit Kaizen”. A form will appear allowing you to edit the various 

properties. Similarly, you could also edit the values via Excel spreadsheet and use the Kaizen 

Import button to bring the values back into eVSM.

Impact (1-5):  What impact this project will have on 

the value stream.

1 = Low, 5 = High

Ease of Implementation (1-5):  How easy/difficult 

will it be to implement this measurable 

improvement to the Value Stream?

1 = Difficult, 5 = Easy

Kaizen Import
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Reduce 

Changeover 

Times

More Frequent 

Deliveries

Kaizen Impact 
Matrix

Plot Kaizen Impact Matrix

001 002

2. Change the fill color of each starburst if you wish.

3. Drag out the Kaizen Impact Matrix icon from the eVSM Kaizen stencil and right-click to plot 

the matrix, which is shown on the next page.

4. If map Kaizens are modified, then the Impact matrix can be updated by selecting it with a right 

mouse click and the command “Update Chart”.

5. Using the Renumber Kaizen button in the toolbar, Kaizens can be renumbered in order starting 

at 001. Select the starbursts in the sequence you want using the Shift key, and then click the 

Renumber Kaizens button. Any un-selected kaizen shapes will get numbered after the selected 

kaizen shapes. 
Renumber Kaizens

Kaizen 
Impact 
Matrix
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6. Drag out the Kaizen Key Creator from the eVSM Kaizen stencil to differentiate each starburst 

by description which is shown under the matrix.

Kaizen Key 
Creator

(001) Reduce Changeover Times

(002) More Frequent Deliveries

Kaizen 

Data

5

4

3

2

1

1 2 3 4 5

Ease Of Implementation

Im
p

a
c
t 
O

n
 V

a
lu

e

Kaizen Impact Matrix

001

002
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Kaizen Risk Matrix

Try This:

1. Drag out a Kaizen starburst shape from the eVSM Kaizen 

stencil. Type “Reduce Cycle Time” into the starburst. Enter the 

values for the likelihood and severity by clicking “Edit 

Kaizen” via right-mouse menu.

Reduce Cycle 
Time

001

2. Drag out another Kaizen Starburst. Type “Incorrect 

Assembly” into the starburst. Enter the likelihood and severity 

values via the Edit Kaizen form.

Incorrect 
Assembly

002

3. Drag out the Kaizen Risk Matrix from the eVSM Kaizen 

stencil.
Kaizen Risk 

Matrix

The Kaizen Risk Matrix plots the kaizen starbursts based on the risk likelihood and risk severity 

values set up in the “Kaizen Properties” form brought up from the right-mouse menu. It also 

multiplies the values together to create an RPN number between 1 to 25.

Risk Likelihood (1-5):  What is the 

likelihood of risk to the Value Stream if this 

project is not done/issue is not addressed?   

1 = Low, 5 = High

Risk Severity (1-5):  What is the 

likelihood/impact in the Value Stream if 

this identified risk did actually occur?   

1 = Low, 5 = High

Kaizen 
Risk 

Matrix
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4. Right-click the chart shape to plot.

5

4

3

2

1

1 2 3 4 5

Risk Likelihood 
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Kaizen Risk Matrix
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Kaizen 

Data

Kaizen 
Risk 
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Formatting the Kaizen Report in Excel 

Once you have clicked the Kaizen Export button in the toolbar and your Excel spreadsheet 

appears, there should be a page named “KaizenFormat”. The changes made on this page will 

effect the actual report which is page named “PageName_Kaizen”. 

Template page for 

editing properties 

for the Kaizen 

Report

In the “KaizenFormat” page in the spreadsheet:

· D1: Change the font color of this cell to set these properties for all Data headers 

· D2: Change the font color, boldness, or italics of this cell to set the default for the Property 

names

· D3: Change for the fill color or row height of this cell to set these properties for all units

· B5: Change the fill color of this cell to set this color for all kaizen numbers

· Each Property header can have a unique fill color, set by this page

· To hide an entire row or column, right-click the row number or column letter and choose 

“Hide”. To unhide that row or column, select the row before and after the hidden one by 

holding down the SHIFT key, or the column before and after the hidden one, and then right-

click and select “Unhide”.

Page name of 

Calculations 

page from 

“Solve”

A ReadMe page that 

lists any editing 

instructions for 

importing values   

Kaizen Report 

(PageName_Kaizen)

The Kaizen Report in Excel can be formatted with custom properties of color, font, visibility, and 

row height. In order to be able to edit this formats, you need a specific Excel file. To get this file 

in the correct location for usage:

1. Create a new folder called "eVSM Standards" at the same level as the “eVSM” folder on the 

C: drive>Program Files (x86)

2. Copy the templates file called “eVSMExcelTemplate.xlt” from the C:Drive>Programs Files 

(x86)>eVSM>Setup>Resources folder to the newly created “eVSM Standards” folder

3. Customize the templates file as needed by following the instructions below

Try This:
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Map Copy

Using the Map Copy button in the toolbar, eVSM can copy your map to another page in the file. 

This function saves time as opposed to using Visio’s regular copy and paste functions. 

1. Click the Map Copy button in the toolbar.

2. A box will appear asking you to enter a page name for the new page in the file.

3. Type in a new name for the page that is going to be created and click OK. 

4. Your entire map will be copied to this new page in the same file. 

Map Copy

Try This:

87



Copyright © 2016 The eVSM Group, All Rights Reserved 

8. Extras

Overview

Provide utilities for upgrading older eVSM maps to v9.Migrate
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Migrate Maps to eVSM v9

The following button in the toolbar will migrate eVSM v6, v7, and v8 maps to eVSM v9 format.

Once a map is migrated to v9, it cannot be opened in older releases of eVSM.

If you need to open an eVSM v9 file in, say v3 (or any earlier version of eVSM) for viewing/

printing purposes only, here is a workaround:

1. Start eVSM and switch VB Macros Off. Click “Tools > Options > Security”.

2. Switch “Off” this checkbox.

3. Exit Visio and open the eVSM v9 file.

Note: Remember to reverse Step 2 above when you wish to use eVSM v9 again.

Migrate
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9. Learn

Overview

Accesses the eVSM on-line help site.

Builds a page full of all the choices available in an eVSM Stack shape 

master. Select a blue icon (from any of the eVSM stencils on the right) 

or green icon (from any Quick stencil) before running this tool.

Provides an on-line access to help resources and training options. 

Help

Icon Search Search for shapes in eVSM stencils.

Stack Help

eLearning Opens the “My Gradebook” page on the eVSM website to check 

course status of eLearning material.  
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Cycle Time Minx.xx

Name Help

For variable name help, right-click any variable and select 

“Name Help” in the menu for a description of the variable.
Process

1

Qty Per Cycle Item1

1

A0020

MinAuto
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Icon Search

The Icon Search button in the eVSM toolbar allows you to search for icons in any of the eVSM 

stencils. The search looks at the name and the brief help behind each icon and presents results in 

a separate search stencil.

1. Click the Icon Search button in the Learn module of the eVSM toolbar. 

2. Look for “OEE” in the Quick Mfg stencil.

3. The resulting shapes associated with OEE will be brought up in a new search stencil.

Try This:
Icon Search
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Stack Help

The Stack Help button creates a new page in the file with all of the available shapes for a 

selected stack. An icon can be identified as a stack shape if it is blue or green in an eVSM 

stencil.

Try This:

1. Select the blue stack Transport Shape from the eVSM Material stencil.

2. Click the Stack Help button in the eVSM toolbar.

3. A new page will be created with the page name “Transport Shapes_Stacks” in the file with all 

of the shapes in the Transport stack. 

Stack Help
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Quick eVSM consists of ready-built stencils for specific application areas. Using these Quick 

Stencils will increase productivity and reduce learning time. Application areas supported include:

§ Quick Manufacturing – plant level maps for discrete parts

§ Quick Manufacturing Network – supply chain, logistics, and 

distribution for discrete parts and assemblies

§ Quick Transactional Pro – transactional processes 

§ Quick Healthcare – patient flows in healthcare

§ Quick Enterprise – supply chain and logistics maps

§ Quick Processing – plant level maps for food products and 

chemical processing

§ Quick Processing Network – supply chain, logistics, and  

distribution for food products and chemical processing 

§ Quick Supply Network – model inbound and outbound supply 

for a product. Includes analyses for lead time, risk, and Total 

Cost of Ownership

§ Quick Warehouse – warehousing process mapping

§ Quick MCT – supports manufacturing critical path time 

calculation assorted with Quick Response Manufacturing

§ Quick Time – measures time (VA & NVA) associated with a 

value stream

10. Quick eVSM

Overview

OpenTo access a Quick stencil, click the Open button in the toolbar.
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Quick Stencils Icon Colors

Red icons are used to initiate the map for the chosen application area. Red icons 

must be dropped first on the new map. The red icons block the map from being 

used with any other Quick stencil.

Green icons, called “Centers”, are used to represent the flow.

Yellow icons, called “add-ons” are additions to “centers” for optional 

calculations. These add-ons must be properly glued to the data shapes under the 

Center. The yellow icons that follow a Center in the Quick stencil can only be 

used with that Center. Note the first word in the add-on names matches the parent 

Center.

Magenta icons represent charts.

White icons used for miscellaneous macro shapes.

The red Data icon acts as the vault for all of the system data for the map such as names, units, 

equations. Each stencil has its own data icon that must be dragged out first. 

Red Icons in the Quick Stencils

Manufacturing
Data

The Quick Stencils will be located on the left side of the Visio drawing page. Quick stencils 

contain macro shapes which are collections of individual shapes, sometimes with names, units 

and calculation equations built-in.

Quick eVSM maps must be initiated with the red icons found at the top of each Quick stencil. 

Once the red icons from a Quick stencil have been dropped on a page, the page is locked for use 

with that Quick stencil. You cannot add content from other Quick stencils. You can however add 

icons from the main stencil (right side) at any time. Some icons (eg. Arrows) are available only 

in the main stencil.
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Time Center

The Time Center shows the actual time (after deducting break times) the value stream operates 

for. Activity level local time can be specified for activities which work to a different schedule. 

Other units are available.

Quick Stencils Centers (Green Icons)

The Centers typically come out with tags and data shapes properly glued to the parent shape 

(green icon)

This is an Operation 

Tag used to sort 

data for charts.

Path List. Used to show specific 

paths. Also used to filter data for 

calculations and charts.

The green shape acts as 

the parent. If moved, 

everything glued to it will 

move with it. 

Units can be changed to 

other compatible units by 

double-clicking.

5

Week

day

xx

Week

Hr

52

Year

Week

U
n

it
s

Process

A0030 P

1

Cycle Time Secx.xx

Qty Per Cycle Item1

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

SecAuto

xx represents mandatory 

data items. Without this 

data, the calculations 

cannot be completed.

Blue “Auto” fields will be 

calculated automatically 

be eVSM.

Customer
Center

all

Customer

Customer 
Demand

Item
Day

xx

A020

The Customer Center represents the customer is where the customer demand is specified. Where 

multiple customers exist, a separate Center can be used to represent each customer.
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Quick Manufacturing

The Quick Manufacturing stencil is designed to represent discrete parts flowing through plant 

level manufacturing value streams. Both, the material and information flow may be represented. 

The Quick Manufacturing stencil includes built-in calculations for:

§ Lead Time, Value added time, Takt time

§ Scrap, OEE, and other common activity losses

§ Energy and space calculations

§ Multi-stations, part-time, over-time, shared resources

§ Cost of activities, inventory, transport, scrap

§ Transport distances

§ Multi-paths

Quick Transactional Pro

Used to draw office, administrative, and general services value stream maps. May be used for 

any value streams concerned primarily with information flow.  

Supported calculations include:

§ Lead Time, Value added time, Takt time, Cumulative Rolling Time

§ %Complete & Accurate (%C&A)

§ Multi-stations, part-time, over-time, shared resources

§ Multi-paths and looping

For tutorials and examples visit: http://www.evsm.com/help

Quick Healthcare

Used to capture value streams that require following a patient through admin and non-clinical 

processes.

Supported calculations include:

§ Lead Time, Value added time, Takt time, Cumulative Rolling Time

§ %Complete & Accurate (%C&A)

§ Multi-stations, part-time, over-time, shared resources

§ Multi-paths and looping

For tutorials and examples visit: 

For tutorials and examples visit: 

http://www.evsm.com/help

http://www.evsm.com/help
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The Quick Processing Network stencil is designed to provide mapping support for supply chain, 

logistics, and distribution value stream mapping of chemicals and food processes, that allows 

calculation of demand, cost and lead times. It is designed to work with Quick Processing. 

For tutorials and examples visit:

Quick Processing Network

http://www.evsm.com/help

The Quick Manufacturing Network stencil is designed to provide mapping support for supply 

chain, logistics, and distribution value stream mapping of discrete parts and assemblies, that 

allows calculation of demand, cost and lead times. It is designed to work with Quick 

Manufacturing. 

For tutorials and examples visit:

Quick Manufacturing Network

http://www.evsm.com/help

The Quick Warehousing stencil is designed to provide mapping support for warehouse process 

mapping.  

For tutorials and examples visit:

Quick Warehousing

http://www.evsm.com/help

Quick Enterprise

The Quick Enterprise stencil is designed to provide mapping support for enterprise, supply chain 

and logistics maps. The stencil was developed after a review of the workbooks “Seeing The 

Whole” and “Lean Fulfillment” from the Lean Enterprise Institute (www.lean.org). The stencil  

has been subsequently refined through enterprise mapping projects the eVSM group has been 

involved in.

For tutorials and examples visit:  

The Quick Processing stencil is designed to provide mapping support for plant level 

manufacturing in Process Industries. The stencil was developed after a review of the Peter King’s 

book “Lean for the Process Industries”. It is an adaption of standard Value Stream Mapping 

methodology to address the non-discrete nature of process manufacturing.. The stencil  has been 

subsequently refined through processing mapping projects the eVSM group has been involved in.

For tutorials and examples visit:

Quick Processing

http://www.evsm.com/help

http://www.evsm.com/help
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The Quick MCT stencil is designed to support manufacturing critical path time calculation within 

the QRM (Quick Response Manufacturing) methodology. Quick MCT has a small set of drag & 

drop shapes and a set of units converters that allows data to be input in production, office or 

calendar units and then converts values to calendar units for consistent output. It has been 

designed to complement the MCT Quick Reference Guide by Rajan Suri (available on our 

website at www.evsm.com/shop). The “critical path” provides the MCT number and this is seen 

visually with its gray and white space components on the MCT chart.

For tutorials and examples visit:

Quick MCT

http://www.evsm.com/help

The Quick Supply Network models inbound and outbound supply for a product. Includes 

analyses for lead time, risk, and Total Cost of Ownership. Maps can be overlaid onto geographic 

view for additional insight. 

For tutorials and examples visit:

Quick Supply Network

http://www.evsm.com/help
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eVSM Wizards are simpler stencils that are meant to be used in conjunction with the Quick 

stencils. They do detailed side calculations related to some aspect of the main map, which the 

values can then be imported into the main map. The Wizards cover areas such as:

§ Kanban – to calculate kanban sizing and quantities 

§ Facility Time Pro – allows direct specification by each 

weekday of times, shift patterns, and related costs. 

§ Manufacturing Multi Station – calculates the properties of 

an equivalent machine that has the same capacity as multiple 

machines with differing properties.

§ Processing Multi Station - calculates the properties of an 

equivalent machine that has the same capacity as multiple 

machines with differing properties.

§ EPEI (Every Part Every Interval) – calculates min possible 

and actual EPEI  intervals for multiple products going 

through a single station with differing demands and lot sizes.

§ POLCA (Paired-cell Overlapping Loops of Cards with 

Authorization) – is a variant of Kanban, suitable for 

companies which produce many different and/or customized 

products.

§ Standard Work – allows layout of standard work with 

manual, machine, and walk times and creates a standard work 

chart.

§ Spaghetti Diagram – allows you to draw paths on a floor 

plan and then export a Path Report with distances to Excel.

§ A3 Report – Creates A3 Reports in Visio with a starter 

template and a dedicated stencil of standard shapes from 

eVSM.

§ Event Circle – allows you to visualize all the transactions in 

a given pathway or process.

11. eVSM Wizards

Overview
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OpenTo access a Wizard stencil, click the Open button in the toolbar.

Wizards contain macro shapes which are collections of individual shapes, sometimes with 

names, units and calculation equations built-in. The icon colors represent the same shapes as in 

the Quick stencils.

Wizard pages must be initiated with the red icons found at the top of each stencil. Once the red 

icons from a Wizard stencil have been dropped on a page, the page is locked for use with that 

Wizard. You cannot add content from other Quick or Wizard stencils. You can however add 

icons from the right side stencils at any time. Some icons (eg. Arrows) are available only in the 

those stencils.

Wiz Kanban

Wiz Facility Time 
Pro

Wiz Mfg Multi 
Station

Wiz Proc Multi 
Station

Wiz EPEI

Wiz POLCA

Wiz Standard 
Work

Wiz Spaghetti

Wiz A3

Wiz Event Circle
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The table below shows which Wizards are designed to work the different Quick stencils. 
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Identify operations in the value stream and start at the 

customer end. 

Use the right mouse button to swap to another process 

shape.

Identifying Operational Steps

Process

Operation 
Shapes

Identifying Customers

Start the map at the customer end.

Drag out the ‘Operation Shapes’ icon and right-click 

the shape to change it to a customer shape. 

Appendix A : Drawing with Base eVSM

Process

Operation 
Shapes

Process

ProcessDrag and drop, then glue arrows to the operations or 

their data shapes for easy future modification of the 

map.

Use the right mouse button to swap to another arrow 

type (like this Push arrow)

Connecting Operational Steps with Arrows

Stepped 
Arrows

Expedited

Information

Kanban

Material

Push

Service

Adding Operational Data

Value stream data which you may later want to use in calculations must be represented in eVSM 

data shapes. eVSM has the following data shapes:

ValueName Unit Value Unit Value Unit

Long NVU Value 
Added

Non Value 
Added

Name Unitx.xx

Short NVU
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ValueName Unit

Process

ValueName UnitValue

Name

Unit

Value Unit

Value Unit

Variable Names and Units

To add variable names/units to the right mouse button (RMB) menu, follow these steps:

1. Click the following button in the eVSM Toolbar to open the Name & Unit Manager (NUM) 

dialog.

2. To add a new unit, click the “New Unit…” button.

NUM

Data shapes consist of two or three fields. To move or delete a data shape, you MUST click on 

the Value field. To edit any of the fields, simply double-click on the desired part and you will be 

able to make any changes.

Data shapes must be glued directly, or via other 

shapes, to the activity they represent.

3. All variable names must have a default 

unit. When adding new variable names, 

first make sure that the unit you 

wish to make the default for the new 

variable, exists in the units list. Then, click 

the “New Name…” button and follow the 

prompts.
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3CO min

20CT sec

3CO min

20CT sec

Process Additional data can be added to a process. Drag & glue a new NVU to 

the bottom of an existing NVU.

Data shapes that do not touch the operation or its data shapes directly 

should be associated with the operation by dragging the flying yellow 

connector and gluing it to the operation.

Note: Flying connectors should NOT be used where shapes are 

touching.

Process

Adding Additional Data Shapes

Long 
NVU

x.xx Unit

xx
Day

s
xx Unit

Process VA and NVA shapes are available to construct a timeline on 

the map.

Glue these shapes to operational shapes with a flying 

connector.

When there are several VA/NVA metrics to be tracked, the 

Long NVU shape should be used instead of the specific VA, 

NVA shapes.

Process

Representing VA & NVA data

Value 
Added 

Non Value 
Added 

Drag out the NVU shape and glue it to the bottom of the inventory rectangle 

to document inventory type and quantity. Use additional triangles and NVU 

blocks for each inventory type.

Representing Inventory Data

After an inventory shape has been dragged out, it can be changed to a variety of inventory 

shapes. Use the right mouse button to swap to another inventory shape (Queue, In-tray etc..).

Representing Inventory & Queues

Inventory 
Shapes

Short NVU

Delay

FIFO Inventory

Hopper

In Tray

Inventory

Kanban Inventory

Package Forming Inventory

Query

Queue

Silo

Supermarket Inventory

Wait

Inventory
Ite
m

20
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20

LH

plts

Supermarket and Buffer shapes work in a similar way to the Inventory 

Shape. Any data must be glued to the base of the shape.

Representing Supermarkets and Buffers

Supermarket

Short NVU

Drag out Transport Shapes and place them on the map or glue them 

to arrows. NVU shapes holding related variables can be attached to 

the base of the icons.

Use the right mouse button to swap to another transport type 

(Train, Helicopter etc..).

Representing Transport Method and Data

Process

Transport 
Shapes

Finished Goods

Representing Transmit Method and Data

Transmit Shapes work in a similar way to Transport 

Shapes and are generally applied to information 

flow.

Transmit 
Shapes

Control 

Activity

Frameless Transport & Transmit Shapes

Transmit 
Shapes

By Foot

Computer

Fax

Pager / Radio

Phone

Post

Print

Web Form

_______________

Framing

Right-click on a transmit or transport shape on the map to show 

alternate methods.

At the bottom of the list is a “Framing” option that allows the 

outer box around the shape to be turned on or off. When turned off 

the shape looks as below:
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Table

This  is a simple starter table that can be further customized:

A right mouse click on any  of the table cells brings up a 

table modification menu (right) allowing for row / column 

addition and modification.

Select Table

View Row and Column Size 

Adjusters

Adjust Table

Clone Row Below

Clone Row Above

Delete Row

Use as Standard Row Height

Clone Column on Right

Clone Column on Left

Delete Column

Use as Standard Column Width

The eVSM Table shape was introduced to allow easy creation of box-score tables on the map.

Starter Table

Working with Tables

Pick the “Select Table” command in the right mouse menu to highlight the 

yellow diamonds. Move these yellow diamonds to the required width and 

height positions. Then click the “Adjust Table” command in the right 

mouse menu.

Resizing Rows and Columns

Moving the Table

To move the table to a new position on the map, click the “Select Table” command in the right 

mouse menu. Then drag the table to the desired location.

Editing Text

Double-Click on a table cell to change its text.
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Header1 Header2

Value2Value1

Header2

Value2

Tables and Spreadsheets

You can transfer table cell data to the spreadsheet with the “eVSM Calculator” button

To transfer the data, the table has to be tagged first.

Each table creates its own worksheet page in the Excel Workbook. If the page name is “CS” and 

the tag is “A010” then the worksheet in Excel will be called “CS_A010”. If formulas are created 

within cells in the spreadsheet, the results of those formulas will appear in the table when the 

eVSM Solve button is clicked.

Operation 
Tag

Solve

A010
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Swimlanes

The eVSM Swimlane function allows drawing of VSMs and flowcharts in swimlane layout, 

horizontally or vertically. The eVSM Swimlane shape is an implementation of the eVSM Table 

function. 

To calculate totals or plot charts for each lane, see the Path List function.

Note: The swim lane function in native Visio is NOT supported with eVSM. The eVSM 

Calculator will not work if the Visio swim lane shape is on your drawing page.

Horizontal 
Swimlane

Vertical 
Swimlane

Lane A     Lane B

L
a
n
e
 A

L
a
n
e
 B

3. Pick the “Select Table” command in the right mouse menu to highlight 

the yellow diamonds. Move these yellow diamonds to the required width 

and height positions. Then click the “Adjust Table” command in the right 

mouse menu.

4. Double-click the “Header” to edit the text.

5. To move the table to a new position on the map, click the “Select 

Table” command in the right mouse menu. Then drag the table to the 

desired location.

Try This:

1. Drag out the Horizontal Swimlane from the eVSM 

Information stencil. 

2. Right mouse click on any of the lanes to bring up the 

modification menu allowing for row/column addition and 

modification.

Select Table

View Row and Column Size Adjusters

Adjust Table

Clone Row Below

Clone Row Above

Delete Row

Use as Standard Row Height

Clone Column on Right

Clone Column on Left

Delete Column

Use as Standard Column Width
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Only shapes with a grey corner in the stencil can be tagged. These are called Excel rowmaker 

shapes since each of these creates its own row in the spreadsheet. 

Row shape examples:

Excel Rowmaker Shapes

Operation 

Shapes

Transport 

Shapes

Table Transmit 

Shapes

Common Calculator Problems

The eVSM Calculator has some requirements, and if these are violated, the calculator will stop 

and display an error message. The problem area will be highlighted on the map with a red circle 

for you to correct. We recommend using the Check button before clicking Solve.

Appendix B : Analysis with Base eVSM

Map.xlsMap.vsd

When the eVSM Calculator is run for the first time, the Excel file is created automatically and 

saved in the same folder as the Visio file. The Excel file is given the same name as the Visio file. 

Unit conversion variables in Excel are also scoped by the page name.

Excel and Visio File Naming

Solve

Duplicate or Unglued Tags: Each Operation Tag on the map must have a unique value and must 

be glued to a valid Row Shape.

Overlapping Data Shapes: Some Data Shapes are hidden behind others because of overlap, and 

is not allowed.

Duplicate Data Shapes: Each Data Shape within a Row Shape collection must have a unique 

variable name. 

Grouped Shapes: eVSM Shapes should not be grouped. The Calculator will abort if grouped 

shapes are found.

Common Calculator Problems
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Data columns sorted 

by variable name

Data in Excel

One row per 

Rowmaker Shape

Rows sorted by 

Operation Tag 

number

All items in a column have same units

Calculations in Excel

Equations may be entered in the spreadsheet cells in which Data Shapes are represented. 

Steps:

The next time the Calculator 

is run, the result of the 

equation will be displayed in 

the appropriate data shape on 

the map. The calculated value 

will be color coded red to 

show it is controlled by Excel.

Note: After the “=” sign, instead of an equation (eg. =C3*D12), static values (eg. =216) can also 

be entered. This allows entry of measured metrics directly in the spreadsheet.

Select 

Cell

1

Type “=” followed 

by an equation

Click the Enter 

button

2

3
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eVSM Equation Manager

Visio

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

All eVSM calculations are done via an integrated Excel spreadsheet. The spreadsheet is created 

automatically when the “eVSM Calculator” function is invoked. Results from calculations in the 

spreadsheet are automatically displayed on the map. eVSM supports two types of equations to 

perform the calculations:

1. Direct Equations – formulas entered directly into cells in Excel.

2. Managed Equations – equations managed by eVSM and automatically inserted as formulas 
in Excel.

This section shows the Managed Equations capability in eVSM.

Managed Equations are created in Visio and stored in the NUM shape. 

When the eVSM Calculator is run, they generate Direct Equations in Excel. 

The Equation Manager form is accessed through the Name and Unit Manager.

Tag Operation VA NVA Data Data Data Data

v
a

lu
e

 a
d

d
e

d

n
o

n
 v

a
lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n

c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

=($AE$18)*100/(($AF$18)*1440)

Name 
Unit 
Data

Managed Equations are 

created and stored in Visio

Direct Equations 

in Excel

Solve

List of Managed 

Equations
On/Off switch 

controls whether or 

not equation will be 

applied when 

Calculator is run

NUM

Creating Managed Equations

Non Value Added (Days)   =
Inventory (Units)

Daily Demand (Units/Day)

In this example, we will set up a Managed Equation to calculate the Non-Value added (NVA) 

times associated with inventory and daily demand. The equation is:
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Our goal is to use a single equation for the variable “Non Value Added” that is applied 

everywhere on the map where this variable exists. We will assume two key rules of the Equation 

Manager:

§ There is only one equation for each target variable name (left-hand side of the equation).

§ An equation is either applied to the whole map (when it is ON), or not applied at all (when 

it is OFF).

Steps:

1. Click the New Eqn.. Button.

3. Enter a name and 

description (optional) 

for the equation.

2. Select the variable name to calculate and its 

corresponding units. This represents the left-hand side 

(LHS) of the equation.

4. Click Insert 

Variable for the 

right-hand side 

(RHS) of the 

equation.

5. Select “Inventory” for  

variable name and select 

the unit

6. Specify 

action to take if 

variable is not 

found on map

7. Select the “ST” option. This specifies how data will get selected from the map. The selections 

are based on the Operation Tag and are explained further in the following pages. 
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8. Click “OK” to return to the previous form. 

9. Type “/” for the divide sign

Solve

Equation Manager Variables Options

§ Same as Target Tag (ST) – Used to select the RHS variable from the same operation tag 

as the LHS variable.

§ Unique Variable On Map (UV) – Can be used when a variable occurs only once on the 

map, so there is no need to specify the operation tag ID for it.

§ All Tags (ATS) - Selects the RHS variable from every tag on map where it exists, and 

makes a list to put in the Excel function. Typical usage: sum all VA times.

§ Downstream Tags (DTS) – Selects the RHS variable from the downstream tag as specified 

by the Tag Seq arrows connecting the tags. Typical usage might be for cumulative 

calculations starting downstream and moving upstream, like effective yield calculations.

§ Upstream Tags (UTS) - Selects the RHS variable from the downstream tag as specified by 

the Tag Seq arrows connecting the tags. Typical usage: cumulative time or cost 

calculations.

11. To convert the Managed Equation into Direct Equations, click the Solve button.

10. Insert the next variable for the RHS. 

Here is the resulting equation:

“ST(Inventory;Unit;0;SKIP)/ST(Customer 

Daily Demand;Unit;0;SKIP)”

To edit variables in the equation, place the 

cursor on the variable and click the 

“Modify Variable..” Button.
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Block Managed Equations

Each target variable (left-hand side of equation) can be driven by only one Managed Equation. 

When the Calculator is run, the Managed Equation will be applied to every instance of the target 

variable. Sometimes, you may want to block the Managed Equation from being applied to some 

instances of the target variable. This can be done with the “Block Managed Equation” shape in 

the eVSM Icons stencil.

Simply glue the “Block Manage Equation” shape to any data shape which you want omitted from 

the Managed Equations calculation.

Note: If the “Block Managed Equation” shape is attached to a data shape AFTER it has already 

been calculated, then you must manually delete its direct equation in Excel before the next 

Calculator run, otherwise the OLD equation will remain in the spreadsheet.

Block Mng 
Equation

x.xxYield %

x.xx Mins

Sequence Arrows & Pipe

The eVSM Equation Manager has additional variable options for usage with variables on 

sequence arrows and pipes. These are primarily development tools for eVSM’s quick stencils and 

their usage without developer training is NOT recommended.
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Index

A
aliases 29

align timeline 27

all paths 40

arrows 102

auto pipe 43

autopath 37

autotag 36

B
blue icons 6

blue stacks 105

browse data 25

C
calculate 46

calculator 107

calculator problems 110

chart variables 71,69

charts 69

check 45

clear 45

conditional color gadget 66

cumulative bar chart 71

current set 22

D
data source 50

data target 50

direct equations 112

E
edit variables 25

equation manager 114,112,22

evsm stencils 5

extras 88

F
filter 74

flying connectors 104

fractional units 23

G
gadget collections 61

gadget color-coding 62

gadget hide/show 62

gadget key points 63

gadget scale factor 62

gadgets 60

grid 5

H
help 90

hide/show 59

highlight path 40

I
icon search 92

improve 78

K
kaizen export 79

kaizen impact matrix 80

kaizen import 79

kaizen properties 78

kaizen risk matrix 83

kaizens 79

L
ladder chart 72

ladder charts 41

lean enterprise institute 4

learn 90

list variables 26,24

M
main stencil 3

managed equations 115,112,22

map copy 87

milestone chart 71

N
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name and unit manager 22,18

non value added 104

num 103,18

nva 104

O
operational data 102

P
path filter list 42

path list 38

path marker 41

paths 41

plot name value 68

printing 8

Q
quick stencils 94,3

R
renumber kaizens 81

S
same paths 39

select timeline 27

sequence 34

sequence arrow 35

shapes 4

show pipes 45

show seq 45

sketch 10

snap 5

solve 46

source and target 50

stack help 93

stencils 4

swimlane 108

T
tables 106

tag seq arrow 35

tags 114,36

text editing 5

text value gadget 64

timeline 27

transport shapes 105

U
unit family 106

units converter 19

V
v9 migration 89

va 104

validate 44

value added 104

var solve 47

variation percentile 49

variational data 47

views 59

visualize 58

W
wall map 11

wizards 100

www.evsm.com/updates 3

X
xl report 55

xy chart 69

Z
zooming 7
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